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Documentation Updates

The title page of this document contains the following identifying information:

• Software Version number, which indicates the software version.

• Document Release Date, which changes each time the document is updated.

• Software Release Date, which indicates the release date of this version of the software.

To check for recent updates, or to verify that you are using the most recent edition of a 
document, go to:

http://h20230.www2.hp.com/selfsolve/manuals 

This site requires that you register for an HP Passport and sign-in. To register for an HP 
Passport ID, go to: 

http://h20229.www2.hp.com/passport-registration.html 

Or click the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product 
support service. Contact your HP sales representative for details.

To check for recent updates of supported system environments, go to: 

http://www.hp.com/go/TDQC_SysReq.

http://www.hp.com/go/TDQC_SysReq
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Support

Visit the HP Software Support web site at:

http://www.hp.com/go/hpsoftwaresupport 

This web site provides contact information and details about the products, services, and 
support that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and 
efficient way to access interactive technical support tools needed to manage your business. 
As a valued support customer, you can benefit by using the support web site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. 
Many also require a support contract.  To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html 

To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp 



5

Table of Contents

Welcome to This Guide .........................................................................9
How This Guide is Organized................................................................9
Documentation Library.......................................................................10
Documentation Library Guides...........................................................11
Additional Online Resources...............................................................15

PART I:  INSTALLATION OVERVIEW

Chapter 1: Installation Process Overview ...........................................19
How to Install and Manage ALM ........................................................19

Chapter 2: About ALM ........................................................................23
Application Lifecycle Management Editions ......................................24
About the ALM Technology ................................................................25

PART II:  UPGRADE

Chapter 3: Upgrade Overview ............................................................29
The Upgrade Process............................................................................30
Planning the Upgrade .........................................................................31
Server Installation................................................................................32
Upgrading Existing Schema ................................................................32
Project Upgrade ...................................................................................40
Project Repository Migration ..............................................................46
Documentation Resources on the Upgrade Process............................47

PART III :  PRE-INSTALLATION PREREQUISITES

Chapter 4: Pre-Installation Checklist...................................................51

Chapter 5: Prerequisites: Windows Operating Systems.....................55
System Configurations: Windows.......................................................55
Required Permissions: Windows .........................................................56
Clustering Configuration: Windows...................................................57
ALM Repository Path: Windows .........................................................57



Table of Contents

6

Chapter 6: Prerequisites: Linux/Oracle Solaris Operating Systems ...59
System Configurations: Linux/Solaris.................................................59
Required Permissions: Linux/Solaris ...................................................60
Minimum Disk Space Requirements ...................................................62
Clustering Configuration: Linux/Solaris.............................................62
ALM Repository Path: Linux/Solaris ...................................................62

Chapter 7: Prerequisites: Oracle Database Servers ............................63
Connecting ALM to an Oracle Database Server..................................63
Site Administration database schema considerations.........................68
Oracle RAC Support.............................................................................70

Chapter 8: Prerequisites: Microsoft SQL Database Servers................73
Connecting ALM to a Microsoft SQL Database Server .......................73
Site Administration database schema considerations.........................77

Chapter 9: Prerequisites: Miscellaneous .............................................79
License File and Maintenance Key......................................................79
Security Passphrases ............................................................................80
Mail Server Information ......................................................................80

Chapter 10: Prerequisites: Client-side ................................................81
System Configurations ........................................................................82
Permissions Required to Download ALM Client

Components ...................................................................................83
Internet Explorer Configuration .........................................................84
Enabling User Account Control (UAC) ...............................................85

PART IV: INSTALLATION

Chapter 11: Installing on Microsoft Windows 
Systems............................................................................................89

About Installing ALM..........................................................................90
Installing ALM.....................................................................................90
Installing ALM in Silent Mode ..........................................................112
Configuring the IIS Mail Service .......................................................113

Chapter 12: Installing on Linux/Oracle Solaris Systems...................115
About Installing ALM........................................................................115
Installing ALM...................................................................................116
Installing ALM in Silent Mode on Linux/Solaris Systems ................139
Working in Console Mode................................................................140



Table of Contents

7

PART V: POST-INSTALLATION

Chapter 13: Getting Started .............................................................145
Browsing the ALM Program Folder ...................................................145
Starting and Stopping ALM Services .................................................146
Starting Application Lifecycle Management on a Client..................147
Registering ALM on a Workstation ...................................................151

Chapter 14: Integrating the ALM Application 
Server with Apache.......................................................................155

Chapter 15: Installing HP ALM Add-ins ............................................159

Chapter 16: Managing the ALM Application Server ........................163
Changing the Heap Memory Size .....................................................164
Changing the Application Server Port Number................................165
Configuring Secure Access on Windows Systems .............................166
Configuring Secure Access on Linux/Solaris Systems .......................169
Application Server Management Tools .............................................172

Chapter 17: Customizing System Files..............................................173
Customizing Site Administration......................................................173
Customizing Menus ..........................................................................175
Understanding the ALM System Tray Icon.......................................178

Chapter 18: Uninstalling ALM...........................................................179
Uninstalling ALM from Windows systems .......................................179
Uninstalling ALM from Linux/Solaris Systems .................................180
Uninstalling ALM Client Components from a Workstation ............180

PART VI: APPENDIX

Appendix A: Troubleshooting the ALM Installation.........................183
Disabling Validation Checks for the Configuration Wizard ............183
Checking the Installation and Configuration Log Files ...................186
ALM Installation Already Exists ........................................................187
Database Validator Fails ....................................................................188
Monitoring ALM Server Fails.............................................................189



Table of Contents

8



9

Welcome to This Guide

Welcome to HP Application Lifecycle Management (ALM). ALM empowers 
IT to manage the core application lifecycle, from requirements through 
deployment, granting application teams the crucial visibility and 
collaboration needed for predictable, repeatable, and adaptable delivery of 
modern applications.

Note: HP Quality Center Enterprise Edition is in Technology Preview. It will 
be released formally after completion of the Technology Preview period.

How This Guide is Organized

The HP Application Lifecycle Management Installation Guide describes the 
system prerequisites and ALM installation process.

It contains the following parts:

 Part I Installation Overview

Presents the whole installation process as a numbered task, enabling you to 
follow the workflow in a simple step-by-step manner. Also provides an 
overview of the available ALM editions and ALM technology.

 Part II Upgrade

Describes all aspects of the various stages involved in the upgrade process. 
Provides details about how to upgrade the Site Administration database 
schema and projects.
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 Part III Pre-Installation Prerequisites

Provides an overview of ALM and the installation process. Also contains 
general, and detailed, prerequisite information for the various supported 
operating systems (Windows, Linux, and Oracle Solaris), and database 
servers (Oracle and Microsoft SQL). Also contains important information 
relating to upgrading projects and database Site Administration schemas.

 Part IV Installation

Describes in detail the steps required to install ALM on Windows, Linux, 
and Oracle Solaris platforms.

 Part V Post-Installation

Describes the various post-installation tasks and available customization and 
management options. Also describes how to uninstall ALM.

 Part VI Appendix

Contains information on troubleshooting the ALM Installation.

Documentation Library

The Documentation Library is an online help system that describes how to 
use ALM. You can access the Documentation Library in the following ways:

➤ Click Documentation Library in the ALM Help menu to open the 
Documentation Library home page. The home page provides quick links 
to the main help topics.

➤ Click Help on this page in the ALM Help menu to open the 
Documentation Library to the topic that describes the current page.
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Documentation Library Guides

The Documentation Library consists of the following guides and references, 
available online, in PDF format, or both. PDFs can be read and printed using 
Adobe Reader, which can be downloaded from the Adobe Web site 
(http://www.adobe.com).

HP Application Lifecycle Management (ALM) Guides

Reference Description

Using this 
Documentation 
Library 

Explains how to use the Documentation Library and how 
it is organized.

What’s New? Describes the newest features in the latest version of 
ALM. 

To access, select Help > What's New.

Product Feature 
Movies

Short movies that demonstrate the main product 
features.

To access, select Help > Product Feature Movies.

Readme Provides last-minute news and information about ALM.

Guide Description

HP ALM User Guide Explains how to use ALM to organize and execute all 
phases of the application lifecycle management process. 
It describes how to specify releases, define requirements, 
plan tests, run tests, and track defects.

HP ALM 
Administrator Guide

Explains how to create and maintain projects using Site 
Administration, and how to customize projects using 
Project Customization.

HP ALM Lab 
Management Guide

Explains how to use Lab Management to manage lab 
resources used for functional and performance testing on 
remote hosts.

HP ALM Tutorial A self-paced guide teaching you how to use ALM to 
manage the application lifecycle management process.

http://www.adobe.com
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HP ALM Performance Center Guides

HP ALM Best Practices Guides

HP ALM Installation 
Guide

Describes the installation and configuration processes for 
setting up ALM Server.

HP Business Process 
Testing User Guide

Explains how to use Business Process Testing to create 
business process tests.

Guide Description

HP ALM Performance 
Center Quick Start

A self-paced guide giving the Performance Center user a 
high level overview of creating and running performance 
tests.

HP ALM Performance 
Center Guide

Explains to the Performance Center user how to create, 
schedule, run, and monitor performance tests. Explains 
to the Performance Center administrator how to 
configure and manage Performance Center projects.

HP ALM Performance 
Center Installation 
Guide

Describes the installation processes for setting up 
Performance Center Servers, Performance Center Hosts 
and other Performance Center components.

HP ALM Performance 
Center 
Troubleshooting 
Guide

Provides information for troubleshooting problems while 
working with HP ALM Performance Center.

Guide Description

HP ALM Agile Testing 
Best Practices Guide

Provides best practices for implementing agile testing 
principles.

HP ALM Business 
Models Module Best 
Practices Guide

Provides best practices for working with the Business 
Models module.

HP ALM Database 
Best Practices Guide

Provides best practices for deploying ALM on database 
servers.

Guide Description
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HP ALM Performance Center Best Practices Guides

HP ALM Entities 
Sharing Best 
Practices Guide

Provides best practices for sharing entities.

HP ALM Project 
Planning and 
Tracking Best 
Practices Guide

Provides best practices for managing and tracking 
releases.

HP ALM Project 
Topology Best 
Practices Guide

Provides best practices for structuring projects.

HP ALM Upgrade 
Best Practices Guide

Provides methodologies for preparing and planning your 
ALM upgrade.

HP ALM Versioning 
and Baselining Best 
Practices Guide

Provides best practices for implementing version control 
and for creating baselines.

HP ALM Workflow 
Best Practices Guide

Provides best practices for implementing workflows.

Guide Description

HP Performance 
Center of Excellence 
Best Practices

Provides best practices for successfully building and 
operating Performance Centers of Excellence.

HP Performance 
Monitoring Best 
Practices

Provides best practices for monitoring the performance 
of applications under test.

Guide Description
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HP ALM API References

Guide Description

HP ALM Project 
Database Reference

Provides a complete online reference for the project 
database tables and fields.

HP ALM Open Test 
Architecture API 
Reference

Provides a complete online reference for the ALM COM-
based API. You can use the ALM open test architecture to 
integrate your own configuration management, defect 
tracking, and home-grown testing tools with an ALM 
project.

HP ALM Site 
Administration API 
Reference

Provides a complete online reference for the Site 
Administration COM-based API. You can use the Site 
Administration API to enable your application to 
organize, manage, and maintain ALM users, projects, 
domains, connections, and site configuration 
parameters.

HP ALM REST API 
Reference

Provides an online reference for the ALM REST-based API. 
You can use the REST API to access and work with ALM 
data.

HP ALM COM 
Custom Test Type 
Developer Guide

Provides a complete online guide for creating your own 
testing tool and integrating it into the ALM environment 
using native COM development tools.

HP ALM .NET Custom 
Test Type Developer 
Guide 

Provides a complete online guide for creating your own 
testing tool and integrating it into the ALM environment 
using a combination of DCOM and .NET classes. 
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Additional Online Resources

The following additional online resources are available from the ALM Help 
menu:

Part Description

Troubleshooting & 
Knowledge Base

Opens the Troubleshooting page on the HP Software 
Support Web site where you can search the Self-solve 
knowledge base. Choose Help > Troubleshooting & 
Knowledge Base. The URL for this Web site is 
http://h20230.www2.hp.com/troubleshooting.jsp.

HP Software Support Opens the HP Software Support Web site. This site 
enables you to browse the Self-solve knowledge base. You 
can also post to and search user discussion forums, 
submit support requests, download patches and updated 
documentation, and more. Choose Help > HP Software 
Support. The URL for this Web site is 
www.hp.com/go/hpsoftwaresupport.

Most of the support areas require that you register as an 
HP Passport user and sign in. Many also require a support 
contract.

To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp

To register for an HP Passport user ID, go to: 

http://h20229.www2.hp.com/passport-registration.html 

HP Software Web site Opens the HP Software Web site. This site provides you 
with the most up-to-date information on HP Software 
products. This includes new software releases, seminars 
and trade shows, customer support, and more. Choose 
Help > HP Software Web site. The URL for this Web site 
is www.hp.com/go/software.

Add-ins Page Opens the HP Application Lifecycle Management Add-
ins Page, which offers integration and synchronization 
solutions with HP and third-party tools.

http://h20230.www2.hp.com/troubleshooting.jsp
http://www.hp.com/go/hpsoftwaresupport
http://h20230.www2.hp.com/new_access_levels.jsp
http://h20229.www2.hp.com/passport-registration.html
http://www.hp.com/go/software
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1
Installation Process Overview

This chapter provides an overview of the HP Application Lifecycle 
Management (ALM) installation process.

How to Install and Manage ALM

This procedure describes the steps involved in installing, customizing, 
troubleshooting, and uninstalling ALM.

This task includes the following steps:

➤ "Verify system configurations" on page 20

➤ "Review information relevant to upgrading the Site Administration 
schema or projects" on page 20

➤ "Review the installation checklist" on page 20

➤ "Verify that you meet all relevant prerequisites" on page 20

➤ "Install ALM" on page 21

➤ "Start Application Lifecycle Management" on page 21

➤ "Customize and configure the ALM installation - Optional" on page 22

➤ "Install Performance Center Server and components - Optional" on 
page 22

➤ "Troubleshoot the ALM Server installation" on page 22

➤ "Uninstall ALM" on page 22



Chapter 1 • Installation Process Overview

20

 1 Verify system configurations

Verify that your server machine meets the ALM system configurations. 
For the recommended and supported system configurations for your ALM 
server machine, refer to the HP Application Lifecycle Management 11.50 
Readme.

Note: The supported environment information in the HP Application 
Lifecycle Management 11.50 Readme is accurate for the ALM 11.50 release, 
but there may be subsequent updates. For the most up-to-date supported 
environments, refer to the HP Software Web site using the following URL: 
http://www.hp.com/go/TDQC_SysReq

 2 Review information relevant to upgrading the Site 
Administration schema or projects

If you worked with a previous version of ALM/Quality Center, you must 
upgrade your Site Administration database schema and projects. For more 
information, see Chapter 3, "Upgrade Overview."

 3 Review the installation checklist

Ensure that you have all the information for installing ALM on a server 
machine. For more information, see Chapter 4, "Pre-Installation 
Checklist."

 4 Verify that you meet all relevant prerequisites

Ensure that you meet the prerequisites for installing ALM on a server 
machine, and for running ALM on client machines. In addition to general 
prerequisites, there are specific prerequisites depending on your operating 
system and database server type. 

For more information, see the following: 

➤ Windows operating systems: Chapter 5, "Prerequisites: Windows 
Operating Systems."

http://www.hp.com/go/TDQC_SysReq
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➤ Linux/Oracle Solaris operating systems: Chapter 6, "Prerequisites: 
Linux/Oracle Solaris Operating Systems."

➤ Oracle database servers: Chapter 7, "Prerequisites: Oracle Database 
Servers."

➤ Microsoft SQL database servers: Chapter 8, "Prerequisites: Microsoft 
SQL Database Servers."

➤ Miscellaneous prerequisites: Chapter 9, "Prerequisites: Miscellaneous."

➤ Client-side prerequisites: Chapter 10, "Prerequisites: Client-side."

 5 Install ALM

You can install ALM on one of the following operating systems: Windows, 
Linux, or Oracle Solaris. For more information, see the following:

➤ Windows operating systems: Chapter 11, "Installing on Microsoft 
Windows Systems."

➤ Linux/Oracle Solaris operating systems: Chapter 12, "Installing on 
Linux/Oracle Solaris Systems."

 6 Start Application Lifecycle Management

After the installation completes, you launch ALM from your Web browser. 
For more information, see Chapter 13, "Getting Started."
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 7 Customize and configure the ALM installation - Optional

You can customize and configure the following aspects of the ALM 
installation:

➤ Apache Web server: Configure the ALM Application Server to work 
with the Apache Web server. For more information, see Chapter 14, 
"Integrating the ALM Application Server with Apache."

➤ Add-ins: You can install ALM add-ins to enhance existing 
functionality. For more information, see Chapter 15, "Installing 
HP ALM Add-ins".

➤ ALM Application Server: ALM comes with built-in application server 
capability. You can perform the following actions on the internal 
application server: update the heap memory value, change default port 
numbers, and configure secure access to ALM. For more information, 
see Chapter 16, "Managing the ALM Application Server".

➤ System files: You can customize various aspects of ALM by creating or 
configuring system files. For more information, see Chapter 17, 
"Customizing System Files".

 8 Install Performance Center Server and components - 
Optional

To work with HP ALM Performance Center, install the Performance 
Center server and components. For more information, refer to the 
HP ALM Performance Center Installation Guide.

 9 Troubleshoot the ALM Server installation

Additional suggestions for dealing with issues relating to the ALM 
installation are described in Appendix A, "Troubleshooting the ALM 
Installation".

 10 Uninstall ALM

For information on how to uninstall ALM from your server machine, see 
Chapter 18, "Uninstalling ALM."
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2
About ALM

This chapter provides information about the available ALM editions and 
ALM technology.

This chapter includes:

➤ Application Lifecycle Management Editions on page 24

➤ About the ALM Technology on page 25
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Application Lifecycle Management Editions

HP Application Lifecycle Management (ALM) is also available in several 
editions which provide subsets of ALM functionality — 
HP ALM Essentials Edition, HP Quality Center Enterprise Edition, and 
HP ALM Performance Center Edition.

For detailed information about the functionality available for each edition, 
refer to the HP Application Lifecycle Management User Guide.

HP ALM Edition Description

HP ALM Edition A unified platform for managing and automating 
processes, activities, and assets for building, testing, 
delivering, and maintaining applications. It includes 
modules for requirements, test, defect, and 
development management, and overall release and 
project planning. HP ALM helps organizations drive 
consistent processes, shared best-practices, and asset 
sharing across projects.

HP ALM Essentials 
Edition

Provides a subset of HP ALM product functionality, 
and is designed to help smaller teams get up and 
running quickly. It provides core functionality for 
requirements management, test management, and 
defect management.

HP Quality Center 
Enterprise Edition

Resides on the same unified platform as HP ALM. It 
delivers core functionality for quality management. It 
supports building a quality center of excellence 
through tight integrations with HP Unified Functional 
Testing, HP Business Process Testing, and HP Sprinter.

HP ALM Performance 
Center Edition

Functionality for the complete management, 
scheduling, running, and monitoring of performance 
test scripts. It resides on the same platform as HP ALM 
and integrates directly with HP ALM and HP 
LoadRunner.
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About the ALM Technology

ALM is an enterprise-wide application that is based on Java 2 Enterprise 
Edition (J2EE) technology. J2EE technology provides a component-based 
approach to the design, development, assembly, and deployment of 
enterprise applications. 

Within the J2EE framework, ALM supports clustering. A cluster is a group of 
application servers that run ALM as if they were a single entity. Each 
application server in a cluster is referred to as a node or a cluster node.

Clusters provide mission-critical services to ensure maximum scalability. 
The load balancing technique within the cluster is used to distribute client 
requests across multiple application servers, making it easy to scale to an 
infinite number of users. The cluster of servers can run on Windows, Linux, 
and Oracle Solaris based platforms.

The following diagram illustrates how ALM client requests are transmitted 
within a cluster.
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➤ HP ALM Client. When users select Application Lifecycle Management or 
Site Administration on their client machine, client components are 
downloaded to their client machine. ALM uses the Component Object 
Model (COM) interface as an interprocess communicator among the 
components.

➤ Internet. Client requests are transmitted via the HTTP protocol to the 
server.

➤ Load Balancer. When working with a load balancer, client requests are 
transmitted to the load balancer and distributed according to server 
availability within the cluster.

➤ Application Server. Client requests are dispatched by servlets to the 
deployed ALM Server. ALM comes with built-in application server 
capability.

The deployed application contains Application Lifecycle Management, 
Site Administration, and associated files which are packaged into a Web 
Application Archive (WAR) file. Client requests from Application Lifecycle 
Management are dispatched to the deployed application.

The Java Database Connectivity (JDBC) interface is used to communicate 
between the application server and the databases.

➤ Databases. The Application Lifecycle Management Site Administration 
schema stores project information, such as domain, project, and user 
data. The schemas can reside on an Oracle or Microsoft SQL Server. For 
detailed guidelines for deploying ALM on database servers, refer to the 
HP ALM Database Best Practices Guide.
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3
Upgrade Overview

This section describes the process for upgrading ALM.

Performance Center: To work with projects created in Performance Center 
versions 9.52 or earlier, you must migrate your projects to align them with 
the required configurations of ALM. For details, refer to the "Upgrade and 
Migration" section in the HP Application Lifecycle Management Performance 
Center Installation Guide.

This chapter includes:

➤ The Upgrade Process on page 30

➤ Planning the Upgrade on page 31

➤ Server Installation on page 32

➤ Upgrading Existing Schema on page 32

➤ Project Upgrade on page 40

➤ Project Repository Migration on page 46

➤ Documentation Resources on the Upgrade Process on page 47
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The Upgrade Process

The upgrade process consists of the following main stages:

 1 Planning the upgrade. Define the scope of your upgrade and plan an 
upgrade strategy. For details, see "Planning the Upgrade" on page 31.

 2 Server installation. Install the new version of ALM. This creates or 
upgrades the site administration schema. There is one schema for the 
ALM site. This schema is created the first time ALM is installed and 
maintains all site administration tables. For details, see:

➤ "Server Installation" on page 32

➤ "Upgrading Existing Schema" on page 32

 3 Restoring projects. If you chose to install ALM on a new server, remove 
your projects from the original server, and restore them on the new server. 
For details on backing up, removing, and restoring projects, refer to the 
upgrade section of the HP Application Lifecycle Management Administrator 
Guide.

 4 Project upgrade. Upgrade the projects that were created in a previous 
version of ALM. Each project has its own project database user schema. 
This schema maintains all data related to the specific project. For details, 
see "Project Upgrade" on page 40.

 5 Project repository migration. If you are upgrading from Quality Center 
10.00 to ALM 11.50, the project repository is automatically upgraded to 
the new optimized repository format. For details, see "Project Repository 
Migration" on page 46.

It is important to be familiar with the upgrade process and plan your course 
of action before you begin. In addition, there may be some steps you must 
take before you perform the actual upgrade. This chapter guides you 
through the process and directs you to the more detailed information and 
instructions for each step.



Chapter 3 • Upgrade Overview

31

Planning the Upgrade

To upgrade from a previous Quality Center or ALM version with minimal 
interruption to your system operations, first become familiar with the 
considerations and recommendations involved in the upgrade process. The 
following guides provide information on upgrade, and are available on the 
HP Software Product Manuals site 
(http://h20230.www2.hp.com/selfsolve/manuals):

HP Application Lifecycle Management Upgrade Best Practices. This guide 
provides information on upgrade methodology and can assist you in 
planning your upgrade. The Upgrade Best Practices guide is available on the 
installation DVD.

The Upgrade Best Practices guide discusses the following:

➤ Determining the need for ALM upgrade

➤ Defining upgrade scope and strategy

➤ Upgrading infrastructure

➤ Upgrading ALM

➤ Choosing the upgrade method

➤ Upgrading projects

➤ Configuring and customizing projects

➤ Upgrading in a testing environment

➤ Planning for production upgrade

HP ALM Database Best Practices Guide. This guide provides best practices 
for implementing HP ALM. Following these best practices can help you 
when upgrading your database or moving to a different database as a part of 
your overall upgrade plan.

http://h20230.www2.hp.com/selfsolve/manuals
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Server Installation

In this stage of the upgrade process you install the new version of ALM.

 1 Before you begin, thoroughly review all prerequisite actions and 
considerations. For details, see Part 3, "Pre-Installation Prerequisites" of 
this guide.

 2 If you choose to upgrade a copy of the existing Site Administration 
schema, see "Upgrading Existing Schema" on page 32.

 3 Review the prerequisites for upgrading a project. For details, see "Project 
Upgrade" on page 40.

 4 Review "Project Repository Migration" on page 46.

 5 Install ALM 11.50. For details, see Part 4, "Installation" of this guide.

 6 Complete any post-installation tasks, such as installing HP ALM Add-ins. 
For details, see Part 5, "Post-Installation", of this guide.

Upgrading Existing Schema

When installing ALM 11.50, you can choose to upgrade a copy of an 
existing Site Administration schema. 

This option creates a copy of the existing Site Administration database 
schema, and then upgrades the copy. Upgrading a copy of the existing 
schema enables you to work with new and upgraded projects, as well as with 
projects from previous versions that have not been upgraded. This allows 
you to upgrade your existing projects incrementally.
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Note: 

➤ Oracle: The new database schema is created in the same tablespace as 
the existing Site Administration database.

➤ This scenario does not apply to working with Performance Center 
projects. After you upgrade LAB_PROJECT, you must then upgrade 
Performance Center projects before they can be used.

For more information on using an existing database schema, see Chapter 7, 
"Prerequisites: Oracle Database Servers," or Chapter 8, "Prerequisites: 
Microsoft SQL Database Servers."

This section also includes:

➤ Guidelines for Upgrading a Copy of the Existing Schema

➤ Recovering a Lost Confidential Data Passphrase

➤ Changes to the Existing Schema and Upgrade Failure

Guidelines for Upgrading a Copy of the Existing Schema
When you choose to upgrade a copy of the existing schema, the copy that is 
created is independent of the existing schema. Any changes subsequently 
made to the original schema through updates in your previous version of 
Quality Center or ALM are not reflected in the upgraded copy of the schema 
that ALM 11.50 uses.

Therefore, consider the following guidelines:

ALM users After you install ALM 11.50, if you add or delete users or 
update user details in your previous version of 
ALM/Quality Center, you must make the same changes in 
ALM 11.50.

ALM 
configuration 
parameters

After you install ALM 11.50, if you modify configuration 
parameters in your previous version of ALM/Quality Center, 
you must make the same changes in ALM 11.50.
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Server node 
configuration

If you are working with server nodes, in the Servers tab in Site 
Administration for ALM 11.50, you must reconfigure the 
settings for the ALM log file and the maximum number of 
database connections.

ALM repository 
path

The repository path in your previous version must be defined 
as a network path, so that it can be accessed by both the 
previous ALM/Quality Center installations and by 
ALM 11.50.

Make sure that different repository paths are defined for both 
versions.

DATACONST 
table

The following constants must be set as network paths in the 
DATACONST table: 

➤ db_directory, tests_directory

➤ unix_db_directory

➤ unix_tests_directory 

This enables them to be accessed by both the previous 
ALM/Quality Center installations and by ALM 11.50.

Confidential data 
passphrase

If you are upgrading an ALM 11.00 version of the schema, 
when configuring the installation you must enter the same 
passphrase as was used in the previous installation. If you do 
not know the passphrase, see "Recovering a Lost Confidential 
Data Passphrase" on page 35.

Schema 
exceptions

If you have made changes to the existing schema, such as the 
addition of tables or columns, the upgrade process may fail. 
To upgrade the existing schema successfully, you can create 
an exception file that instructs ALM to ignore these changes 
during the upgrade process. For more information, see 
"Changes to the Existing Schema and Upgrade Failure" on 
page 36.
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Recovering a Lost Confidential Data Passphrase
If there is an existing installation of ALM, and you do not know the 
Confidential Data Passphrase, perform the following steps:

Notes:

➤ The procedure must be performed before beginning the ALM 11.50 
installation.

➤ The procedure can be performed whether you are installing ALM 11.50 
on the same machine as the existing installation, or on a separate 
machine, for example, if you are adding a node to a cluster.

 1 On the machine where the ALM is currently installed, navigate to the 
following directory:

➤ Windows: c:\ProgramData\HP\ALM\conf

➤ Linux/Solaris: /var/opt/HP/ALM/conf

 2 If you are installing ALM 11.50 on a different machine, copy the 
qcConfigFile.properties file and place the copy on the machine where 
you plan to install the latest version of ALM. Place the file in the same 
location on the new machine. 

Note: If the <Deployment path>\HP\ALM\conf (Windows) or 
<Deployment path>/HP/ALM/conf (Linux/Solaris) directories do not exist 
on the new machine, manually create them. In such a case, make sure 
that the new directories have the required permissions to be accessed by 
the configuration tool.

If you are installing ALM 11.50 on the same machine, create a copy of the 
qcConfigFile.properties file. 

 3 Open the copy of the qcConfigFile.properties file and delete all 
information except for the line that starts with initstring.
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 4 Save the copy. If you are installing ALM on a new machine, skip to step 6.

 5 If you are upgrading ALM on the same machine as the previous 
installation:

 a Uninstall the current version of ALM. For information about 
uninstalling ALM, see Chapter 18, "Uninstalling ALM." The 
uninstallation procedure does not remove the existing 
qcConfigFile.properties file.

 b Overwrite the existing qcConfigFile.properties file with the version 
you edited in step 3.

 6 When you run the Configuration Wizard after the installation, the wizard 
detects a previous ALM installation and prompt you to accept the current 
settings. Accept the current settings. When the wizard reaches the 
Security page the previous Confidential Data Passphrase appears.

Changes to the Existing Schema and Upgrade Failure
If changes have been made to the existing Site Administration database 
schema, these changes may cause the upgrade process to fail. Examples of 
such changes are the addition of tables or columns, or changes to field 
types. 

To prevent the upgrade process from failing, perform one of the following 
actions:

Note: It is advisable to perform these actions in this order. 

 1 Manually repair inconsistencies between the old schema and the new 
schema. For more information about manually repairing the old schema, 
refer to the "Changing the Database User Schema" section in the appendix 
to the HP Application Lifecycle Management Administrator Guide.
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 2 If it is not feasible to manually repair the existing schema, you can create 
an exception file that instructs ALM to ignore these changes during the 
upgrade process. After creating the exception file, save it in an accessible 
location on your system. After installing ALM the Site Administration 
Database Schema page in the configuration wizard prompts you to add 
the file to the configuration process. As a result, the changes to the 
existing schema do not cause the upgrade process to fail.

For information about how to create an exception file, see "Creating an 
Exception File" below.

 3 If you cannot manually repair the inconsistencies, or create an exception 
file, create a new schema and then migrate the projects using the Restore 
Project option in Site Administration.

To create a new schema, in the ALM Server Configuration Wizard, Site 
Administration Database Schema page, select the Create a New Schema 
option.

If ALM is already installed on the server machine, you can rerun the 
ALM Server Configuration Wizard as follows:

➤ Windows: Select Start > Programs > HP ALM Server > 
Server Configuration Wizard

➤ Linux/Solaris: Navigate to the /opt/HP/HP_ALM_Server directory and 
run the run_after_install.sh file.

For information on migrating projects, refer to the "Upgrading Projects to 
a New Version" chapter in the HP Application Lifecycle Management 
Administrator Guide.
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Creating an Exception File

The following procedure describes how to create an exception file.

To create an exception file:

 1 Copy the SchemaExceptions.xml file from the ALM installation directory. 
By default, the file is located in 
<ALM installation path>\data\sa\Admin\MaintenanceData.

 2 Place the copy of SchemaExceptions.xml in an accessible location on your 
system. 

 3 Edit the file and define exceptions. For example:

➤ For an extra table:

<TableMissing>

<object pattern="MY_Table" type="extra"/>

</TableMissing>

➤ For an extra view:

<ViewMissing>

<object pattern="MY_VIEW" type="extra"/> 

</ViewMissing> 

➤ For an extra column:

<ColumnMissing>

<object pattern="MY_COLUMN" type="extra"/>

</ColumnMissing>

➤ For an extra index:

<IndexMissing>

<object pattern="MY_INDEX" type="extra">

</IndexMissing>
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➤ For an extra constraint:

<ConstraintMissing>

<object pattern="MY_CONSTRAINT" type="extra">

</ConstraintMissing>

➤ For multiple occurrences of extra elements:

For example, multiple extra columns:

<ColumnMissing>

<object pattern="MY_COLUMN_1" type="extra"/>

<object pattern="MY_COLUMN_2" type="extra"/>

</ColumnMissing>

 4 Save the SchemaExceptions.xml file.
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Project Upgrade

After installing the latest version of ALM, you must upgrade your projects to 
the new version. This section provides an overview of the project upgrade 
process.

For details on how to run these upgrade processes in Site Administration, 
refer to the upgrade section of the HP Application Lifecycle Management 
Administrator Guide.

This section includes:

➤ Upgrading Projects from Previous Versions and Editions

➤ Upgrading LAB_PROJECT

➤ Upgrading Projects

➤ Upgrading Version Control

➤ The Project Upgrade Tools
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Upgrading Projects from Previous Versions and Editions
The following table describes the process required for working with a project 
created in an earlier version:

From version: To ALM 11.50:

Quality Center 10.00 or 
ALM 11.00

1  Install ALM 11.50. The installation process updates 
your Site Administration schema.

2  If you were working with Performance Center 
11.00, you must upgrade LAB_PROJECT using ALM 
Site Administration 11.50. For details, refer to the 
HP Application Lifecycle Management Administrator 
Guide.

3  Upgrade your projects using ALM Site 
Administration 11.50. For details, refer to the 
HP Application Lifecycle Management Administrator 
Guide.

Quality Center 9.2 First upgrade projects to Quality Center 10.00 or ALM 
11.00. For details, refer to the relevant the Installation 
Guide.

Quality Center 9.0 Projects must first be upgraded to Quality Center 
10.00. For details, refer to the HP Quality Center 10.00 
Installation Guide.

ALM Essentials Edition 
11.50 or 
Performance Center 
Edition 11.50

If you are upgrading to HP Quality Center Enterprise 
Edition or HP ALM Edition, you do not need to 
upgrade your projects.

Quality Center 
Enterprise Edition 11.50

If you are upgrading to HP ALM Edition, you do not 
need to upgrade your projects.
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Upgrading LAB_PROJECT
If you were previously working with Performance Center 11.00, upgrade 
LAB_PROJECT before upgrading any Performance Center projects. You 
manage LAB_PROJECT project details from the Lab Management tab in Site 
Administration. 

Upgrading LAB_PROJECT includes the following stages:

Note: This procedure describes the flow for performing a gradual upgrade on 
a new server. 

 1 On the original Quality Center or ALM server in Site Administration, 
disable LAB_PROJECT.

 2 Back up the LAB_PROJECT schema and file system.

 3 On the new ALM server, remove LAB_PROJECT. (If you chose to create a 
new Site Administration schema during installation, a new LAB_PROJECT 
was created. To work with your ALM/Performance Center 11.00 
LAB_PROJECT, you must first remove the new LAB_PROJECT from the 
ALM 11.50 server.)

 4 Restore the ALM Performance Center 11.00 LAB_PROJECT on the new 
ALM 11.50 server.

 5 On the new ALM server, in Site Administration, run the Verify tool. The 
Verify tool checks if LAB_PROJECT contains any common problems.

 6 If problems are detected, run the Repair tool to fix problems that can be 
resolved automatically. Manually fix any problems that cannot be 
handled automatically by the Repair tool.

 7 Run the Upgrade tool on the new ALM server to upgrade LAB_PROJECT 
to ALM 11.50.

 8 When the upgrade process completes, activate LAB_PROJECT.



Chapter 3 • Upgrade Overview

43

Upgrading Projects
Upgrading a project includes the following stages:

Note: 

➤ This procedure describes the flow for performing a gradual upgrade on a 
new server.

➤ If you were previously working with ALM/Performance Center 11.00, 
first upgrade LAB_PROJECT, and then any Performance Center template 
projects, before upgrading Performance Center projects.

 1 Version Control: Make sure that all entities in the project are checked in. 
Version control enabled projects from Quality Center 10.00 or 
ALM/Performance Center 11.00 cannot be upgraded to ALM 11.50 while 
there are checked out entities. For more details, see "Upgrading Version 
Control" on page 44.

 2 On the original Quality Center or ALM server, in Site Administration, 
disable the project.

 3 Back up the project schema and file system.

 4 Restore the project on the new ALM server.

 5 On the new ALM server, in Site Administration, run the Verify tool. The 
Verify tool checks if the project contains any common problems.

 6 If problems are detected, run the Repair tool to fix problems that can be 
resolved automatically. Manually fix any problems that cannot be 
handled automatically by the Repair tool.

 7 Run the Upgrade tool on the new ALM server to upgrade the project to 
ALM 11.50.

 8 To enable Lab Management or Performance Center functionality in the 
project, enable ALM Lab Extension.

 9 Finally, activate the project.
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Upgrading Version Control
Upgrading Quality Center 10.00 or ALM 11.00 version control enabled 
projects. Version control enabled projects from Quality Center 10.00 or 
ALM 11.00 cannot be upgraded to ALM 11.50 while there are checked out 
entities. All entities must be checked in in the corresponding version of 
Quality Center or ALM.

Upgrading from legacy version control projects. To work with projects from 
Quality Center 9.0 or Quality Center 9.2 that use version control, you must 
first upgrade to Quality Center 10.00, migrate legacy version control data, 
and then upgrade to ALM 11.50. For information on migrating legacy 
version control data to Quality Center 10.00, see HP Software Self-solve 
knowledge base article KM632120 
(http://h20230.www2.hp.com/selfsolve/document/KM632120). (Requires 
HP Passport sign-in credentials)

The Project Upgrade Tools
Project upgrade can fail due to various reasons. ALM provides two 
preparation tools that reduce the risk of failure: Verify Project and Repair 
Project.

Note: These tools are also applicable when upgrading LAB_PROJECT.

For details on how to run these tools, refer to the upgrade section of the 
HP Application Lifecycle Management Administrator Guide.

Verify Project

The Verify Project tool searches for the most common causes of failure. The 
tool runs a number of tests and produces a list of problems that are detected 
in the project. The report is displayed on-screen and you can choose to save 
it to file.

The Verify Project tool is designed to ensure that the upgrade process runs 
smoothly. However, be aware that there may be specialized cases (primarily 
related to customization or integrations) that the Verify Project tool may not 
identify, and this may lead to post-upgrade challenges.

http://h20230.www2.hp.com/selfsolve/
document/KM632120
http://h20230.www2.hp.com/selfsolve/
document/KM632120
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Repair Project

Use the Repair Project tool to fix those detected problems that can be 
resolved automatically.

Upgrade Project

When you launch the Upgrade Project tool, it runs a sequence of internal 
steps:

 1 Pre-Upgrade Verification and Repair. The sequence begins by running the 
Verify Project tool to check the project for problems. If the Verify Project 
tool detects only problems that can be fixed automatically, the Repair 
Project tool is launched.

When the Repair Project tool ends its run, the Verify Project tool is rerun, 
to ensure that project is now ready for upgrade.

 2 Upgrade. After checking that the project is clear of problems, the actual 
upgrade process is launched. The Upgrade Project tool performs the 
following actions:

➤ Modifies the project schema. This usually involves adding new tables 
and columns.

➤ Modifies the data in the project schema, usually by adding new 
records.

➤ Modifies the project repository, which stores the project files.

 3 Post-Upgrade Verification. After the Upgrade Project tool ends 
successfully, the Verify Project tool runs once more, to check the project’s 
state after upgrade.
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Project Repository Migration

HP ALM introduces an advanced architecture to store project files on the file 
system – the optimized repository.

When upgrading projects from Quality Center 10.00 to ALM 11.50, the 
project repository is automatically upgraded to the optimized repository 
format. This is carried out in two stages:

 1 The first stage is performed during the actual upgrade of the project. In 
this stage, all files in the repository are scanned and their names are 
stored in a project table.

 2 After upgrade is completed the project is reactivated. The repository files 
are gradually migrated to the new system. In this stage, the files are 
moved from their old location to their new location in the optimized 
repository.

This second phase of the repository migration is carried out behind the 
scenes. Users can work in the project even while it is in progress. 
Depending on various factors, such as the size of the repository and the 
network speed, the file migration may take up to several days.

For more details, refer to the upgrade and repository migration sections of 
the HP Application Lifecycle Management Administrator Guide.
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Documentation Resources on the Upgrade Process

The following additional upgrade resources are available from the HP 
Manuals Site at the following URL: 
http://h20230.www2.hp.com/selfsolve/manuals.

➤ HP Application Lifecycle Management Administrator Guide

➤ HP ALM Upgrade Best Practices (also available on the installation DVD)

➤ HP ALM Database Best Practices

Additional resources are available on the HP Software Support Site at the 
following URL: http://www.hp.com/go/hpsoftwaresupport (Requires 
HP Passport sign-in credentials). You can search the Self-solve knowledge 
base for additional articles related to upgrade, such as:

➤ KM1302383 - Error codes referenced in the Verify and Upgrade process

➤ KM189834 - How to switch database servers for Quality Center server

➤ KM194388 - Can the database back-end used by Quality Center be migrated 
from Oracle to MS SQL or vice versa

➤ KM1281892 - Useful information about the upgrade process in ALM11. 
Provides links to many additional resources on upgrade, performance, 
database issues, troubleshooting, and more.
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4
Pre-Installation Checklist

Review and verify the following checklist before installing ALM. This 
checklist outlines the information that you must supply during the 
installation process. For more detailed prerequisite information, see the 
following:

➤ Windows operating systems: Chapter 5, "Prerequisites: Windows 
Operating Systems."

➤ Linux/Oracle Solaris operating systems: Chapter 6, "Prerequisites: 
Linux/Oracle Solaris Operating Systems."

➤ Oracle database servers: Chapter 7, "Prerequisites: Oracle Database 
Servers."

➤ Microsoft SQL database servers: Chapter 8, "Prerequisites: Microsoft SQL 
Database Servers."

➤ Miscellaneous prerequisites: Chapter 9, "Prerequisites: Miscellaneous." 

➤ Client-side prerequisites: Chapter 10, "Prerequisites: Client-side."
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✔ Check Information Required

Installation 
Machine

➤ Operating system version

➤ CPU type

➤ Free disk space

➤ Free memory

For the list of supported system environments, refer to: 
http://www.hp.com/go/TDQC_SysReq.

Setup Paths ➤ Installation path

➤ Deployment path

Notes: 

➤ You can accept the default paths offered by the 
Installation and Configuration wizards, or enter 
alternative paths.

➤ The installation path must not include folders with 
accented characters (for example, ä, ç, ñ).

➤ You must have full permissions on the installation 
and deployment directories. For more information, 
see the following:

➤ Windows operating systems: "Required 
Permissions: Windows" on page 56.

➤ Linux/Solaris operating systems: "Required 
Permissions: Linux/Solaris" on page 60.

License Key ➤ License file

➤ Maintenance key

Cluster 
Description

➤ Is clustering used? 

➤ Cluster hosts

Encryption 
Passphrases

➤ Confidential data storage passphrase

Notes:

➤ In a cluster, use the same passphrase on all nodes.

➤ When upgrading from an ALM 11.00 version of the 
Site Administration database schema, you must 
enter the same passphrase as was used for the 
previous installation.

➤ Communication security passphrase

http://www.hp.com/go/TDQC_SysReq
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Application 
Server

The port number.

Mail Server ➤ Server type

➤ Server host

➤ Server port

Demo Project ➤ Do you require the Web-based demo application for 
work with the HP Application Lifecycle Management 
Tutorial?

Database 
Server

➤ Database type

➤ Database version

➤ Database server name

➤ Database administrator user name

➤ Database administrator user password

➤ Database port

If you use Oracle:

➤ Database SID

➤ Default tablespace

➤ Temp tablespace

Site 
Administration

➤ Site administrator user name

➤ Site administrator password

✔ Check Information Required
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Existing ALM/ 
Quality Center 
Installation

If there is an existing Site Administration schema, 
provide the following information for the existing 
version: 

➤ ALM/Quality Center version

➤ ALM/Quality Center host

➤ Will the same Site Administration schema be used in 
the new version?

➤ Confidential data passphrase

➤ Database server name

➤ Database administrator user name

➤ Database administrator password

➤ Site Administration database schema name

➤ Site Administration database schema password

➤ Repository folder

➤ Site administrator user name

➤ Site administrator password

Repository ➤ Repository folder

✔ Check Information Required
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5
Prerequisites: Windows Operating 
Systems

This chapter provides an overview of the prerequisites for installing ALM on 
Windows-based operating systems.

This chapter includes:

➤ System Configurations: Windows on page 55

➤ Required Permissions: Windows on page 56

➤ Clustering Configuration: Windows on page 57

➤ ALM Repository Path: Windows on page 57

System Configurations: Windows

Verify that your server machine meets the ALM system configurations. For 
the recommended and supported system configurations for your ALM server 
machine, refer to the HP Application Lifecycle Management 11.50 Readme.

Important: The supported environment information in the HP Application 
Lifecycle Management 11.50 Readme is accurate for the ALM 11.50 release, but 
there may be subsequent updates. For the most up-to-date supported 
environments, refer to the HP Software Web site using the following URL: 
http://www.hp.com/go/TDQC_SysReq

ALM can be deployed on a VMware ESX/ESXi server according to the 
VMWare guest operating system compatibility matrix.

http://www.hp.com/go/TDQC_SysReq
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Required Permissions: Windows

Verify that you have the required permissions to install ALM on a server 
machine.

If you are upgrading from a previous version of ALM/Quality Center with a 
remote repository, the ALM/Quality Center application server user account 
must have network access to the remote repository. For more information. 
contact your network administrator.

To install ALM on Windows, you must be logged on as a local or domain 
user with administrator permissions. The user name of the logged on user 
installing ALM cannot include a pound sign ("#") or accented characters (for 
example, ä, ç, ñ).

Notes:

➤ If the repository is on a remote machine, or to use a Microsoft SQL server 
with Windows authentication, you must log on as a domain user and 
local administrator.

➤ You must disable User Account Control (UAC) during the ALM 
installation and configuration.

You must have the following file system and registry key permissions:

➤ Full read permissions to all the files and directories under the directory in 
which ALM is installed. The installation directory path is specified by the 
user during installation. By default, ALM writes the installation files to:
C:\Program Files\HP\HP Application Lifecycle Management.

➤ Full read, write, and execute permissions to the directory on which ALM 
is deployed. The deployment directory is specified by the user during 
installation. By default, ALM is deployed in C:\Users\All Users\HP\ALM.

➤ Full read and write permissions to the repository directory which 
contains the sa and qc directories. The repository path is specified by the 
user during installation. By default, it is located under the ALM 
deployment directory. For more information on the repository, refer to 
the HP Application Lifecycle Management Administrator Guide.
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➤ Full read permissions to the system root (%systemroot%) directory. If you 
do not have these permissions, you can still install ALM, but you cannot 
install any patches. 

➤ Full read and write permissions to the installation and configuration log 
files directory. Installation and configuration log files are written to 
C:\Users\All Users\HP\ALM\log.

➤ Full read and write permissions to all the keys under 
HKEY_LOCAL_MACHINE\SOFTWARE\Mercury Interactive.

Clustering Configuration: Windows

Check with your system administrator whether you are installing ALM on a 
single node or as a cluster. For more information on cluster nodes, see 
Chapter 11, "Installing on Microsoft Windows Systems."

If you are installing ALM on cluster nodes, verify which machine to use as 
the first node to start the installation and the number of machines you 
should use. This depends on the number of users and availability 
considerations. When installing ALM on additional nodes, install the same 
version of ALM on all nodes, and insert the same repository and database 
details that you used on the first node. You must use the same Confidential 
data passphrase on all nodes.

ALM Repository Path: Windows

The location of the repository directory is specified by the user during 
installation. The default location is: C:\ProgramData\HP\ALM\repository. 
You must have full control permissions to the ALM repository path as 
described in "Required Permissions: Windows" on page 56.
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6
Prerequisites: Linux/Oracle Solaris 
Operating Systems

This chapter provides an overview of the prerequisites for installing ALM on 
a Linux or an Oracle Solaris operating system.

This chapter includes:

➤ System Configurations: Linux/Solaris on page 59

➤ Required Permissions: Linux/Solaris on page 60

➤ Minimum Disk Space Requirements on page 62

➤ Clustering Configuration: Linux/Solaris on page 62

➤ ALM Repository Path: Linux/Solaris on page 62

System Configurations: Linux/Solaris

Verify that your server machine meets the ALM system configurations. For 
the recommended and supported system configurations for your ALM server 
machine, refer to the HP Application Lifecycle Management 11.50 Readme.

Important: The supported environment information in the HP Application 
Lifecycle Management 11.50 Readme is accurate for the ALM 11.50 release, but 
there may be subsequent updates. For the most up-to-date supported 
environments, refer to the HP Software Web site using the following URL: 
http://www.hp.com/go/TDQC_SysReq

http://www.hp.com/go/TDQC_SysReq
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Consider the following for implementing ALM configurations:

➤ Verify that you have a supported kernel by running uname -a.

➤ ALM can be deployed on a VMware ESX/ESXi server according to the 
VMWare guest operating system compatibility matrix.

Note: Only Linux operating systems can be deployed on a VMware server. 
Solaris operating systems are not supported.

Required Permissions: Linux/Solaris

Verify that you have the required permissions to install ALM on a server 
machine.

If you are upgrading from a previous version of ALM/Quality Center with a 
remote repository, the ALM/Quality Center application server user account 
must have network access to the remote repository. For more information. 
contact your network administrator.

Note:

The instructions in this chapter apply if you are installing ALM as a root 
user. For non-root user related information, see the following HP Software 
Self-solve knowledge base articles (Requires HP Passport sign-in credentials):

➤ Installing ALM without root user permissions (sudo installation):   
http://support.openview.hp.com/selfsolve/document/KM916123

➤ Installing ALM with root user permissions, but starting ALM without root 
user permissions: 
http://support.openview.hp.com/selfsolve/document/KM1365972

http://support.openview.hp.com/selfsolve/document/KM916123
http://support.openview.hp.com/selfsolve/document/KM916123
http://support.openview.hp.com/selfsolve/document/KM1365972
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You must have the following file system permissions:

➤ Full read and write permissions for all the files and directories under the 
directory on which ALM is installed. The installation files are used for 
configuring the server. By default, the ALM installation files are written 
to: /var/opt/HP/HP_ALM_Server.

➤ Full read and write permissions to the directory on which ALM is 
deployed. The deployment directory is specified by the user during 
installation. By default, ALM is deployed on: /var/opt/HP/ALM.

➤ Full read and write permissions to the repository directory which 
contains the sa and qc directories. The repository path is specified by the 
user during installation. By default, it is located under the ALM 
deployment directory. For more information on the repository, refer to 
the HP Application Lifecycle Management Administrator Guide.

➤ Full read and write permissions to the installation and configuration log 
files directory. Installation and configuration log files are written to:
/var/opt/HP/ALM/log.

➤ Full read and write permissions to the file delivery logs. The log files are 
written to /var/log.

➤ If the file repository is located on a remote machine:

➤ On the file server machine, share the file repository directory so that 
the user running the installation is the owner of the files.

➤ On the ALM machine, or on each cluster node, create a mount 
directory that points to the file repository directory.
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Minimum Disk Space Requirements

The following partitions have minimum disk space requirements: 

➤ /opt: Requires at least enough free space to accommodate the size of ALM 
after it has been installed. The approximate size of an installation is 
300MB, though the exact amount of space may vary from installation to 
installation.

➤ /var: Requires at least enough free space equal to the space on the 
installation DVD, approximately 150MB. A copy of the installation is 
stored in this partition.

➤ /tmp: Requires a large amount of free space. The exact amount cannot be 
specified as this partition is also consumed by the operating system. It is 
advisable that the amount of free space is equal in size to ALM after it has 
been installed, which is approximately 300MB.

Clustering Configuration: Linux/Solaris

Check with your system administrator whether you are installing ALM on a 
single node or as a cluster. For more information on cluster nodes, see 
Chapter 12, "Installing on Linux/Oracle Solaris Systems."

If you are installing ALM on cluster nodes, verify which machine to use as 
the first node to start the installation, and the number of machines you 
should use. This depends on the number of users and availability 
considerations. When installing ALM on additional nodes, install the same 
version of ALM on all nodes, and insert the same repository and database 
details that you used on the first node. You must use the same Confidential 
data passphrase on all nodes. 

ALM Repository Path: Linux/Solaris

The location of the repository directory is specified by the user during 
installation. The default location is: /var/opt/HP/ALM/repository. You must 
have full control permissions to the ALM repository path as described in 
"Required Permissions: Linux/Solaris" on page 60.
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7
Prerequisites: Oracle Database Servers

This chapter provides an overview of the prerequisites for connecting 
HP Application Lifecycle Management (ALM) to an Oracle database server.

In addition to the information presented in this chapter, you can find more 
information on configuring the database server, including information on 
supported character sets, in the HP ALM Database Best Practices Guide.

This chapter includes:

➤ Connecting ALM to an Oracle Database Server on page 63

➤ Site Administration database schema considerations on page 68

➤ Oracle RAC Support on page 70

Connecting ALM to an Oracle Database Server

Verify the following:

Database type and 
version

Verify that ALM supports your database type and version. 
For the list of supported databases, refer to: 
http://www.hp.com/go/TDQC_SysReq.

Database server 
name

Verify the name of the database server.

Database user 
permissions

Verify that you have the database permissions required to 
install ALM on the Oracle database server. For a list of 
required permissions, see "User Permissions for 
Connecting ALM to an Oracle Database" on page 64.

http://www.hp.com/go/TDQC_SysReq
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User Permissions for Connecting ALM to an Oracle 
Database
To connect ALM to an Oracle database server, the installing database user 
must have sufficient permissions to perform certain administrative tasks in 
Oracle. These tasks include creating the ALM project user schema, copying 
data between projects, and checking that there is sufficient storage in a 
specific tablespace.

Site Administration 
database schema 

To install ALM on an existing Site Administration 
database schema (second node or upgrade), you must 
have:

➤ The existing database schema name and the database 
administrator permissions required to connect ALM to 
the database server.

➤ Full read/write permissions on the existing repository.

➤ ALM must have access to the previous Site 
Administration schema repository path.

➤ Full read/write permissions for the ALM user to the 
previous schema repository path.

➤ The Confidential data passphrase that was used to 
create the existing schema.

For schema name and password considerations, see "Site 
Administration database schema considerations" on 
page 68.

Database tablespace 
name and size

➤ Verify the name of the database server, and check the 
connection to the database server. Ping the database 
server machine name to test DNS resolution.

➤ Verify you have the tablespace names (default and 
temporary) and the minimum tablespace sizes for 
storing the Site Administration database schema.

➤ Verify that the tablespace is not locked.

Database Column 
Length Semantics

Ensure that column length is defined according to 
characters, and not according to bytes.
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If you are unable to use the Oracle system user due to security reasons, it is 
recommended that your database administrator create an ALM database 
administrative user, for example qc_admin_db, with the specific privileges 
required to install ALM.

Your database administrator can create an ALM database administrative user 
using the example script, qc_admin_db___oracle.sql, which is located in the 
\Utilities\Databases_scripts directory on the installation DVD. This script 
creates the ALM database administrative user with the recommended grants 
required on the database. Your database administrator should run the script 
and create this user on the staging database server.

This section includes:

➤ "Database Administrative User Privileges" on page 65

➤ "Project User Schema Privileges" on page 67

Database Administrative User Privileges

Following are the privileges required by the ALM database administrative 
user. Additional explanations about these privileges can be found in the 
notes at the end of the table.

Privilege Description

CREATE SESSION WITH 
ADMIN OPTION (1)

ALM uses this privilege to connect to the database as 
the ALM database administrative user.

CREATE USER Required to create a new project user schema when 
creating a new ALM project.

DROP USER When deleting an ALM project, ALM attempts to 
remove the Site Administration database schema 
from the database server. If there is an insufficient 
privileges error, ALM ignores the error and requests 
that the user notify the database administrator to 
delete (drop) the database user schema.

CREATE TABLE WITH 
ADMIN OPTION (1)

Required for granting this permission to a newly 
created ALM project user schema.

CREATE VIEW WITH 
ADMIN OPTION (1)

Required to create views for ALM projects.
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CREATE TRIGGER WITH 
ADMIN OPTION (1)

Required to create triggers for ALM projects. ALM 
uses database triggers to collect change history for 
specific tables.

CREATE SEQUENCE WITH 
ADMIN OPTION (1)

Required to create sequences for ALM projects.

CREATE PROCEDURE 
WITH ADMIN OPTION (1)

Required to create stored packages for ALM projects. 
ALM uses packages to collect change history for 
specific tables.

CTXAPP ROLE WITH 
ADMIN OPTION (1)

Enables ALM to use the Oracle text searching feature. 
This role exists only if the Oracle text search 
component was installed and enabled on the 
database server.

SELECT ON 
DBA_FREE_SPACE (2)

Required to check free space on the database server 
prior to creating a new Site Administration database 
schema or a new project.

SELECT ON 
SYS.DBA_TABLESPACES 
(2)

Required to collect a list of tablespaces that exist on 
the database server prior to creating a new Site 
Administration database schema or a new project.

SELECT ON 
SYS.DBA_USERS (2)

Required to verify the existence of specific database 
project users. For example, you might want to verify 
the existence of an Oracle CTXSYS user before 
creating a new ALM project.

SELECT ON 
SYS.DBA_REGISTRY (2)

Required to verify that the text search component is 
installed on the database server.

SELECT ON 
SYS.DBA_ROLES (2)

Required to verify that the text search role (CTXAPP) 
is installed on the database server.

Privilege Description
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Project User Schema Privileges

When creating a new project or restoring an existing project, ALM creates a 
project user schema. This user schema hosts all the tables that are used by 
the project for storing and retrieving data. Following are the required 
privileges for an ALM project user schema:

SELECT ANY TABLE WITH 
ADMIN OPTION (1)

and

INSERT ANY TABLE

Required for various administrative operations when 
upgrading the Site Administration database schema 
during installation using the copy and upgrade 
method, and for enhancing performance when 
copying a project that has the same source and target 
database server.

Notes:

➤ (1) An ALM database administrative user must have privileges with Admin 
Option.

➤ (2) The SELECT ON SYS privileges can be given directly by the table owner, or 
through a database application role. To avoid giving these privileges each time, 
you can grant this role to the ALM database administrative user. The 
recommended name for this role is QC_SELECT_ON_SYS_OBJECTS. You can 
create this role using the qc_sys_db___oracle.sql example script, which is 
located in the \Utilities\Databases_scripts directory on the installation DVD. 
You should run this script before you run the qc_admin_db___oracle.sql script.

Project User Schema 
Privilege

Description

QUOTA UNLIMITED ON 
<default tablespace>

Required for creating database objects that are owned 
by the ALM project user schema. This privilege allows 
users to create tables in the default tablespace. It 
replaces the UNLIMITED TABLESPACE system privilege 
that gave users system privileges to create tables in any 
tablespace, including the SYSTEM tablespace.

CREATE SESSION ALM uses this privilege to connect to the database user 
schema in order to perform required operations. For 
example creating database objects such as tables, and 
using them to insert, retrieve, and delete data.

Privilege Description
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Tip: The installation DVD contains an example script that describes the 
recommended permissions required for the ALM database project user 
schema. This script contains information and does not need to be run. It is 
located at \Utilities\Databases_scripts\qc_project_db___oracle.sql.

Site Administration database schema considerations

Be aware of the following schema name and password considerations:

➤ The default Site Administration database schema name is qcsiteadmin_db. 
If you want to rename the schema, you can change the name in the 
configuration wizard. For more information, see the following:

➤ Windows systems: Step 18 on page 96.

➤ Linux/Solaris systems: Step 19 on page 125.

➤ You can create your own ALM user password for accessing the Site 
Administration database schema.

➤ CREATE TABLE

➤ CREATE VIEW

➤ CREATE TRIGGER

➤ CREATE SEQUENCE

➤ CREATE PROCEDURE

➤ CTXAPP Role

For a description of these privileges, see the table of 
required ALM database administrative user privileges 
on page 65.

Project User Schema 
Privilege

Description
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➤ If there is an existing Site Administration database schema, you can create 
a copy of the existing schema and upgrade the copy. This enables you to 
work with ALM 11.50 and previous versions of ALM/Quality Center 
simultaneously.

Note: This scenario does not apply to working with Performance Center 
projects. After you upgrade LAB_PROJECT, you must then upgrade 
Performance Center projects before they can be used.
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Oracle RAC Support

Oracle RAC is a way to enhance Oracle database availability and scalability, 
allowing it to interact with more than one database instance. 

ALM RAC support includes:

➤ Load balancing between Oracle instances.

➤ Failover between all specified Oracle RAC nodes at initial connection.

ALM RAC support does not include:

➤ TAF (Transparent Application Failover) support. A user failing to complete 
a request upon an Oracle instance crash is required to perform the activity 
again with a working Oracle instance.

To enable Oracle RAC support:

 1 Verify that a file containing information of Oracle database addresses is 
saved on your ALM machine. The file is named tnsnames.ora. The file 
should contain information similar to the following examples:

➤ This first example shows an RAC TNS Alias using all cluster nodes in 
the ADDRESS sub-section and a sample of utilizing the Load balance 
and Failover features:

OrgRAC =
(DESCRIPTION =

(ADDRESS_LIST=
(FAILOVER = on)
(LOAD_BALANCE = on)
(ADDRESS= (PROTOCOL = TCP)(HOST = server1)(PORT = 1521))
(ADDRESS= (PROTOCOL = TCP)(HOST = server2)(PORT = 1521))
(ADDRESS= (PROTOCOL = TCP)(HOST = server3)(PORT = 1521))

)
(CONNECT_DATA=

(SERVICE_NAME = myrac.yourcompany.com)
)

)
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➤ This second example shows an RAC TNS Alias using Single Client 
Access Name (SCAN). This enables Oracle 11gR2 clients to connect to 
the database with the ability to resolve multiple IP addresses, reflect 
multiple listeners in the cluster and handle public client connections. 
For more information on working with RAC SCAN, refer to the Oracle 
documentation.

 2 Verify that you have the address of the TNS server to which ALM should 
refer, for example, OrgRAC.

OrgRAC_Scan =
(DESCRIPTION =

(ADDRESS_LIST=
(FAILOVER = on)
(LOAD_BALANCE = on)
(ADDRESS= (PROTOCOL = TCP)(HOST = myrac-cluster-scan)(PORT = 
1521))

(CONNECT_DATA=
(SERVICE_NAME = myrac.yourcompany.com)
)

)
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8
Prerequisites: Microsoft SQL Database 
Servers

This chapter provides an overview of the prerequisites for connecting 
HP Application Lifecycle Management (ALM) to a Microsoft SQL database 
server.

In addition to the information presented in this chapter, you can find more 
information on configuring the database server, including information on 
supported character sets, in the HP ALM Database Best Practices Guide.

This chapter includes:

➤ Connecting ALM to a Microsoft SQL Database Server on page 73

➤ Site Administration database schema considerations on page 77

Connecting ALM to a Microsoft SQL Database Server

Verify the following:

Database type and 
version

➤ Verify that ALM supports your database type and 
version. For the list of supported databases, refer to: 
http://www.hp.com/go/TDQC_SysReq.

➤ Verify the database server authentication type: 
Windows authentication or Microsoft SQL Server 
authentication. If you upgrade to ALM 11.50, you must 
use the same type of Microsoft SQL Server 
authentication that you used before the upgrade.

➤ For Microsoft SQL Server Windows Authentication, 
check that you can log in to the database. 

http://www.hp.com/go/TDQC_SysReq
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Database server 
name

Verify the name of the database server.

Database user 
permissions

Verify that you have the database permissions required to 
connect ALM to the Microsoft SQL database server (not 
applicable for Windows Authentication). For a list of 
required permissions, see "User Permissions for 
Connecting ALM to a Microsoft SQL Server" on page 75.

Site Administration 
database schema

To install ALM on an existing Site Administration 
database schema (second node or upgrade), you must 
have:

➤ The existing database schema name and the database 
administrator permissions required to connect ALM to 
the database server.

➤ Full read and write permissions on the existing 
repository.

➤ ALM must have access to the previous schema 
repository path.

➤ Full read/write permissions for the ALM user to the 
previous schema repository path.

➤ The Confidential data passphrase that was used to 
create the existing schema.

For schema name and password considerations, see "Site 
Administration database schema considerations" on 
page 77.

Text Search Verify that the text search component is installed on the 
server, even if you do not intend to use it.
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User Permissions for Connecting ALM to a Microsoft SQL 
Server
To connect ALM to a Microsoft SQL database server, the installing database 
user must have sufficient permissions to perform certain administrative 
tasks in SQL.

If you have the SQL sa user, you can use this user to install ALM. If you are 
unable to use the SQL sa user due to security reasons, it is recommended 
that your database administrator create an ALM database administrative 
user, for example td_db_admin, with the specific privileges required to install 
ALM.

The td_db_admin user must have the Database Creators role. You can also 
grant the td_db_admin user the Security Administrators role, which will 
allow it to create a td user with only those privileges required for running 
ALM. 

Alternatively, you can create a td user before installing ALM. To create a td 
user, follow steps 1-3 below, and type td as the user name. The td user should 
be assigned the database db_ddladmin role. It is important that the td user is 
not assigned any server role.

This section contains the following procedures:

➤ "To create an ALM database administrative user on a Microsoft SQL 
Server:" on page 76

➤ "To test the ALM database administrative user (SQL Server 
Authentication):" on page 76

➤ "To test the ALM database administrative user permissions (Windows 
Authentication):" on page 77
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To create an ALM database administrative user on a Microsoft SQL Server:

 1 Open the SQL Server Management Studio.

 2 In the Object Explorer pane, under the ALM database server, expand the 
Security folder.

 3 Right-click the Logins folder, and select New Login.

 4 Type td_db_admin as the user name, and select the authentication type 
(enter password if necessary).

 5 Click the Server Roles tab, and select the dbcreator option.

 6 Click OK.

To test the ALM database administrative user (SQL Server Authentication):

➤ Verify the select sysdatabases table permission in the master database:

➤ Verify the create database permission:

➤ Verify the drop database permission:

➤ Verify the select syslogins permission:

Note: The dbOwnerName must be set to td.

SELECT name FROM sysdatabases where name=<db_name>

CREATE DATABASE <dbName> -- the database name must not already exist

DROP DATABASE <database_name> -- the database name must exist

SELECT COUNT(*) FROM master..syslogins WHERE name=<dbOwnerName>
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To test the ALM database administrative user permissions (Windows 
Authentication):

➤ Verify the change database context permission:

➤ Verify the create database permission:

➤ Verify the select on syslogins permission:

➤ Verify the select on sysusers permission:

Site Administration database schema considerations

Be aware of the following schema name and password considerations:

➤ The default Site Administration database schema name is qcsiteadmin_db. 
If you want to rename the schema, you can change the name in the 
configuration wizard. For more information, see the following:

➤ Windows systems: Step 18 on page 96.

➤ Linux/Solaris systems: Step 19 on page 125.

➤ You can create your own ALM user password for accessing the Site 
Administration database schema.

USE <dbName>

CREATE DATABASE <dbName> -- the database name must not already exist

SELECT COUNT(*) FROM master..syslogins WHERE name='<dbOwnerName>'

SELECT COUNT(*) FROM master..sysusers WHERE name='<dbOwnerName>'
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➤ If there is an existing Site Administration database schema, you can create 
a copy of the existing schema and upgrade the copy. This enables you to 
work with ALM 11.50 and previous versions of ALM/Quality Center 
simultaneously.

Note: This scenario does not apply to working with Performance Center 
projects. After you upgrade LAB_PROJECT, you must then upgrade 
Performance Center projects before they can be used.
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9
Prerequisites: Miscellaneous

This chapter provides an overview of miscellaneous prerequisites for 
installing HP Application Lifecycle Management (ALM).

This chapter includes:

➤ License File and Maintenance Key on page 79

➤ Security Passphrases on page 80

➤ Mail Server Information on page 80

License File and Maintenance Key

Verify that you have the ALM license file and maintenance key.

➤ To activate your license, visit the HP Software Licensing Portal 
(http://www.hp.com/software/licensing) and enter your Entitlement Order 
Number.

The license file has a .dat file extension by default. Make a note of where 
you save the file, as during the ALM configuration process you need to 
specify a path to it.

If you do not have a license, visit the HP Software Licensing Portal 
(http://www.hp.com/software/licensing) and click the Contact Licensing 
Support link.

➤ The maintenance key was supplied to you with the product package when 
you purchased ALM. This field is not mandatory.

http://www.hp.com/software/licensing
http://www.hp.com/software/licensing
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Security Passphrases

Verify that you have passphrases for confidential data and communication 
security encryption.

For secondary cluster nodes, verify that you have the confidential data 
encryption passphrase that you used to install the primary cluster.

When upgrading from an ALM 11.00 version of the Site Administration 
database schema, you must use the same confidential data passphrase as was 
used for the previous installation.

Performance Center: You must use the same communication security 
passphrase for the ALM and Performance Center server configurations.

Mail Server Information

A mail server enables ALM users to send emails to other users in a project. 
You select which server to use as part of the installation configuration 
process.

Decide before installing ALM which mail server to use. Ask your system 
administrator for assistance. If you are using an SMTP Server, check that you 
have the SMTP Server name and port. The installer checks that the specified 
mail server name and port are valid and that the mail server is running.
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10
Prerequisites: Client-side

This chapter provides an overview of the prerequisites for working with 
HP Application Lifecycle Management (ALM) on a client machine. The steps 
described in this chapter are performed on the client, and not on the 
machine on which ALM is installed.

This chapter includes:

➤ System Configurations on page 82

➤ Permissions Required to Download ALM Client Components on page 83

➤ Internet Explorer Configuration on page 84

➤ Enabling User Account Control (UAC) on page 85
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System Configurations

Verify that client machines meet the ALM system configurations. For the 
supported and recommended system configurations for ALM clients, refer to 
the HP Application Lifecycle Management 11.50 Readme.

Important: The supported environment information in the HP Application 
Lifecycle Management 11.50 Readme is accurate for the ALM 11.50 release, but 
there may be subsequent updates. For the most up-to-date supported 
environments, refer to the HP Software Web site: 
http://www.hp.com/go/TDQC_SysReq

Required Software
The following must be installed on client machines:

➤ Microsoft Visual C++ 2005 SP1 Redistributable Package MFC Security 
Update (32-bit version)

➤ Microsoft .NET Framework 4

Additional Considerations

The following considerations must also be taken into account:

➤ You must download the 32-bit version of Microsoft Visual C++ even if you 
are using a 64-bit operating system.

➤ If you are integrating ALM with other HP testing tools, you must modify 
the DCOM permissions on your client machine. For more information, 
see HP Software Self-solve knowledge base article KM187086 
(http://h20230.www2.hp.com/selfsolve/document/KM187086). (Requires HP 
Passport sign-in credentials)

ALM Edition: Modifying DCOM permissions is not required for running 
Functional test sets (server-side test execution).

➤ You can work with the ALM client using a remote desktop.

http://h20230.www2.hp.com/selfsolve/
document/KM187086
http://www.hp.com/go/TDQC_SysReq
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➤ For customers using remote or mass distribution mechanisms, ALM client 
components can be deployed locally on workstations by running a self-
extracting msi file. You build the msi file by running the HP ALM Client 
MSI Generator available from the More HP Application Lifecycle 
Management Add-ins page. For more information on running add-ins, 
see Chapter 15, "Installing HP ALM Add-ins".

Permissions Required to Download ALM Client
Components

To enable ALM to work with HP testing tools as well as various other 
integrations and third-party tools, you need to log in to the client machine 
with administrator privileges. These privileges are required to install the 
HP ALM Client Registration add-in, which you use to register ALM client 
components and Site Administration client components on your client 
machine. For more information, see "Registering ALM on a Workstation" on 
page 151.

File System Permissions
You must have the following file system permissions:

➤ Full read and write permissions on the HP\ALM-Client deployment folder.

This is located at:

➤ Windows 7/2008/2008R2: %ALLUSERSPROFILE%

➤ Windows XP: %ALLUSERSPROFILE%\Application Data

➤ Full read and write permissions to the Temp (%TEMP% or %TMP%) 
directory. The installer program writes installation and log files to this 
directory. This is generally located at:

➤ Windows XP: 
C:\Documents and Settings\<username>\Local Settings\Temp.

➤ Windows 7/2008/2008R2: 
C:\Users\<username>\AppData\Local\Temp
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Internet Explorer Configuration

Before you download Application Lifecycle Management on a client 
machine, you must perform the following configurations to the Internet 
Explorer browser on the client machine.

➤ Configure the Custom Level security settings. The Custom Level security 
setting should be configured for the specific zone of the ALM server.

➤ Set Internet Explorer as the default Web browser. This ensures that 
external links to ALM entities can open in ALM.

To configure security settings on the client machine:

 1 In Internet Explorer, select Tools > Internet Options. The Internet Options 
dialog box opens.

 2 Click the Security tab. The Web content zone of the ALM server (Internet 
or Local intranet) is automatically selected. Click Custom Level.

 3 In the Security Settings dialog box, configure the following settings:

Under .NET Framework-reliant components:

➤ Set Run components not signed with Authenticode to Enable.

➤ Set Run components signed with Authenticode to Enable. 

Under ActiveX controls and plug-ins:

➤ Set Run ActiveX controls and plug-ins to Enable.

➤ Set Download signed ActiveX controls to Enable or Prompt.

Note: You do not need to enable Download signed ActiveX controls if you 
install the ALM client using the HP ALM Client MSI Generator Add-in. 
This allows you to install all ALM modules on a client machine without 
downloading them through a browser. For more information on 
installing add-ins, see Chapter 15, "Installing HP ALM Add-ins".
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 4 On Windows 7:

 a It is suggested that you add the ALM server site to the Trusted Sites 
security zone. This is not mandatory. 

 b Disable the Protected Mode for the Trusted Sites security zone.

 5 Click OK.

To set Internet Explorer as the default web browser:

 1 In Internet Explorer, select Tools > Internet Options. The Internet Options 
dialog box opens.

 2 Click the Programs tab.

 3 Under Default web browser, make sure that Internet Explorer is set as the 
default browser. If not, click the Make default button.

Enabling User Account Control (UAC)

If you enable UAC on a Microsoft Windows 7, 2008, or 2008R2 operating 
system, be aware of the following considerations:

➤ To register ALM client components, you must run Internet Explorer as the 
administrator.

➤ To register ALM client components on a shared location of a client 
machine, you must run Internet Explorer as the administrator.

➤ Administrator permissions are required to run the 
ClientMSIGenerator.exe file. In addition, you must run the .exe file as the 
administrator.
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11
Installing on Microsoft Windows 
Systems

This chapter describes how to install HP Application Lifecycle Management 
(ALM) on Windows operating systems. It also describes how to install ALM 
silently.

Note: For information on installing ALM on Linux/Solaris systems, see 
"Installing on Linux/Oracle Solaris Systems" on page 115.

This chapter includes:

➤ About Installing ALM on page 90

➤ Installing ALM on page 90

➤ Installing ALM in Silent Mode on page 112

➤ Configuring the IIS Mail Service on page 113
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About Installing ALM

You can install ALM on a single node or as a cluster. When you install ALM 
on cluster nodes, all nodes must be identical. For example, all nodes must 
use the same operating system, ALM repository location, and Site 
Administration database. In addition, you must install the same version of 
ALM on all nodes.

Note: When you are installing ALM on a secondary node of a cluster, you 
are not required to set up the database, because it was set up when you 
installed the primary node. Some of the dialog boxes described in this 
installation procedure are needed only for the primary node and are not 
displayed if you are installing a secondary node.

Installing ALM

This section describes how to install ALM 11.50.

Before installing ALM, consider the following:

➤ Verify that you meet the various installation prerequisites. For 
prerequisite information, see the relevant chapters in Part 3, "Pre-
Installation Prerequisites."

➤ If you encounter problems during the ALM installation process, see 
Appendix A, "Troubleshooting the ALM Installation," for troubleshooting 
suggestions.
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To install ALM:

 1 If you have been working with a previous version of Quality Center or 
ALM, back up your existing projects before installing the new version. For 
more information, refer to the HP Application Lifecycle Management 
Administrator Guide.

 2 Log in to the ALM server machine with the appropriate permissions. For a 
list of required permissions, see "Required Permissions: Windows" on 
page 56.

 3 If Quality Center or ALM is installed on the machine, uninstall it. For 
more information, see Chapter 18, "Uninstalling ALM."

 4 Make sure the following services are started on the machine:

➤ Secondary Logon

➤ Windows Management Instrumentation

 5 Insert the ALM 11.50 Software installation DVD into the DVD drive and 
navigate to, and run the appropriate .msi installation file for your 
operating system (32-bit or 64-bit).

 6 The HP ALM Installation wizard starts, displaying the Welcome page. 
Click Next.

 7 The License Agreement page opens.

Read the license agreement. To accept the terms of the license agreement, 
select I Agree. 

Click Next.

 8 The Customer Information page opens. Type your Name and 
Organization. Click Next.

 9 The Select Installation Folder page opens. Specify the location to which 
you want to deliver ALM installation files. Click the browse button to 
choose a location, or accept the default location.

Make sure to enter a case-sensitive unique name for the installation 
folder.

For more information on the required installation directory permissions, 
see "Required Permissions: Windows" on page 56.

Click Next.
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 10 The Confirm Installation page opens.

To review or change any settings, click Back.

To accept the settings and start the installation process, click Next. The 
ALM files are installed on the server machine.

Note: If anti-virus software is installed on the server machine, it checks 
every file as it is being copied. Therefore, deployment may take longer 
than expected.

When the installation process completes, the Installation Complete page 
opens. Click Finish.

 11 The ALM Configuration wizard opens, displaying the Welcome page. 
Click Next.

 12 If the Configuration wizard detects settings from a previous ALM 
installation, the Current Settings page opens.
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➤ Select Yes to use the current settings as default settings for the current 
installation. You can make changes to any of the default settings 
during the wizard.

➤ Select No to clear all settings in the Configuration wizard.

Click Next.

 13 The License Key page opens.

License key file. Select one of the following options:

➤ Browse to or enter the ALM license file path.

➤ If you do not have a license file, select Use Evaluation Key for a 30-day 
trial version of ALM. From the drop-down list, select the edition to 
install for the trial period.

Maintenance key. Type the maintenance number supplied to you when 
you purchased ALM.

For more information on the license file and maintenance key, see 
"License File and Maintenance Key" on page 79.

Click Next.
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 14 The Database Server page opens.

Under Database Type, select the database type for the Site Administration 
database schema.

If you select a Microsoft SQL Server, choose the authentication type:

➤ Microsoft SQL Server (SQL Server Auth.). Authenticates the user to the 
database using a database user name and password.

➤ Microsoft SQL Server (Windows Auth.). Windows authentication relies 
on the user being authenticated by the operating system.

For more information on database requirements, see Chapter 7, 
"Prerequisites: Oracle Database Servers," and Chapter 8, "Prerequisites: 
Microsoft SQL Database Servers."

Note: When upgrading a project to ALM 11.50, you must use the same 
type of SQL authentication that you used before the upgrade.
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 15 Under Database Connection, specify database connection information.

To use an Oracle RAC database, proceed to step 16.

Select one of the following options:

➤ Database Parameters. Select this option to enter database server 
information using the following fields:

➤ DB host name. Type the database server name. For example, 
dbsrv01.

➤ DB port number. Type the database server port number, or accept 
the default port number.

➤ Oracle SID. Type the Oracle system identifier. This is an Oracle 
parameter that identifies the specific Oracle instance on the host 
machine on which the Oracle server is installed.

➤ Connection String. Select this option to type a formulated database 
server connection string.

 16 To use an Oracle RAC database, select Connection String, and enter a 
connection string, specifying the location of the tnsnames.ora file, and 
the TNS server to which ALM should refer. Use the following example:

For more information on prerequisites for Oracle RAC support, see 
"Oracle RAC Support" on page 70.

 17 Under Database Administrator Login, specify the following database 
connection information (Not applicable for Microsoft SQL Server 
Windows Authentication):

➤ DB admin user name. Type the name of the user with the 
administrative permissions required to install ALM on the database 
server. 

➤ DB admin password. Type the database administrator password.

Click Next.

jdbc:mercury:oracle:TNSNamesFile=<tnsnames.ora location>;
TNSServerName=OrgRAC



Chapter 11 • Installing on Microsoft Windows Systems

96

 18 The Site Administration Database Schema page opens. 

Under Selected Action, choose one of the following:

➤ Create a New Schema. Creates a new schema. 

➤ Upgrade a copy of the existing schema. Creates a copy of the existing 
Site Administration database schema, and upgrades the copy. Choose 
this option to work in ALM 11.50 and previous versions of 
ALM/Quality Center simultaneously. For more information, see 
"Upgrading Existing Schema" on page 32.

If you select this option, the Schema Exceptions File option appears. If 
you have defined an exception file for the upgrade process, click 
Browse and navigate to the location where it was saved before the 
installation. For more information about exception files, see "Changes 
to the Existing Schema and Upgrade Failure" on page 36.
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➤ Connect to existing schema / second node. This option can be used in 
two scenarios:

➤ If you are reinstalling ALM and would like to reconnect to the same 
Site Administration database schema.

➤ If you have an existing node and you want to install ALM on 
another node to create a cluster. For more information on cluster 
configuration, see "Clustering Configuration: Windows" on page 57.

Note: This option enables you to connect to an ALM 11.50 Site 
Administration database schema only. To connect to an earlier 
version, you must first upgrade the schema. For more information, 
see "Upgrading Existing Schema" on page 32.

 19 When connecting ALM to an Oracle database server:

If you are installing ALM on a secondary node or if the Site 
Administration database already exists, the new Site Administration 
database schema is created in the same tablespace as the existing schema. 
Proceed to step 23.

Type the following information:

➤ Default Tablespace. Select a default storage location from the list.

➤ Temporary Tablespace. Select a temporary storage location from the 
list.

 20 Under SA Schema Details, type the following information:

➤ Schema name. Type a Site Administration database schema name, or 
accept the default schema name.

Note: When upgrading an existing Site Administration database 
schema to work in ALM 11.50, you must use the same name that you 
used before the upgrade.
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➤ Schema password. Enter the following information, depending on 
your database type:

➤ Oracle: A default password is created which you can accept or 
change.

➤ Microsoft SQL Server (SQL Auth.): ALM uses the td user to create the 
Site Administration database schema. For more details on the td 
user, see "User Permissions for Connecting ALM to a Microsoft SQL 
Server" on page 75.

Type a password for the td user that complies with your 
organization’s password policy, or keep the default tdtdtd password.

➤ Microsoft SQL Server (Windows Auth.): Not applicable.

➤ New Schema name. If you selected Upgrade a copy of the existing 
schema, type a name for the upgraded copy of the database schema.

Click Next.
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 21 The Security page opens.

Passwords for accessing external systems (databases and LDAP) are stored 
by ALM after encryption. Enter a Confidential data passphrase that ALM 
uses to encrypt the information.

Make a note of the passphrase for future support calls. You will also need 
the passphrase if you choose to redeploy ALM and choose to upgrade a 
copy of the existing Site Administration Database Schema.



Chapter 11 • Installing on Microsoft Windows Systems

100

Select Use default value to use the default confidential data encryption 
passphrase. By selecting this option however, the encrypted information 
is more vulnerable to unauthorized access.

Confidential Data Passphrase Considerations

➤ When upgrading from an ALM 11.00 version of the Site 
Administration database schema, you must enter the same passphrase 
as was used for the previous installation. If you do not have a note of 
the passphrase, there is a workaround to recover it. However, you will 
have to abort the configuration process and then begin again once 
complete. For details, see "Recovering a Lost Confidential Data 
Passphrase" on page 35.

➤ If you are planning to migrate Performance Center and/or Lab 
Management enabled projects onto the server on which you are 
performing the installation, you must use the same Confidential Data 
Passphrase that was defined on the server on which the projects were 
created.

➤ If you are installing ALM on a cluster, you must use the same 
passphrase for all nodes.

➤ After completing the server configuration wizard, you cannot change 
the confidential data encryption passphrase.

➤ The passphrase is case-sensitive. Also check that there are no empty 
spaces before or after the passphrase.
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 22 Communication between ALM and other HP BTO applications is enabled 
after authentication by a Single Sign-On (SSO) token. Enter a 
Communication security passphrase that ALM uses to encrypt the SSO 
token.

Notes:

➤ The communication security passphrase is stored as the value of the 
COMMUNICATION_SECURITY_PASSPHRASE site configuration parameter. 
For more information, refer to the HP Application Lifecycle Management 
Administrator Guide.

➤ Performance Center: You must use the same communication security 
passphrase for the Performance Center server configuration.

Click Next.
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 23 The Site Administrator User page opens.

You use the site administrator name and password that you define here to 
log in to Site Administration for the first time. After installation, you can 
change the site administrator or add other site administrators. Type a site 
administrator User name (maximum length 60 characters) and Password, 
and retype the password to confirm.

If you are upgrading a copy of the existing Site Administration database 
schema, by default the same user and credentials are applied to the 
upgraded schema. To create an additional user, select Create additional 
Site Administrator user (this field appears only when you are upgrading a 
copy of the existing schema).
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Notes:

➤ The user name cannot include the following characters: \ / : * ? " < > |

➤ It is important that you remember the site administrator user name 
and password so you can log in to Site Administration.

Click Next.

 24 The File Repository Path page opens.

In the File repository path box, click the browse button to choose a 
repository path, or accept the default path. Make sure to enter a unique 
case-sensitive name for the repository folder.
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Notes:

➤ Make sure you select a path where you have full read and write 
permissions.

➤ To work with cluster nodes, make sure that all nodes have access to the 
file repository path and that the path is UNC. All nodes in the cluster 
must have the same repository path.

Using the BASE_REPOSITORY_PATH site configuration parameter, you 
can create a location for a repository path where new projects will be 
located. Performing this action, therefore, means there will be two 
repository paths - the previous path containing older projects, and a 
second path containing projects created subsequently. For details, refer to 
the HP Application Lifecycle Management Administrator Guide.

For more information on the Repository path, see "ALM Repository Path: 
Windows" on page 57. 

Click Next.



Chapter 11 • Installing on Microsoft Windows Systems

105

 25 The Application Server page opens.

In the Deployment path box, specify the location in which you want to 
deploy ALM application files. Click the browse button to choose a 
location, or accept the default location. It is recommended that you keep 
the default.
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 26 In the Web Server box, you can change or keep the default HTTP port 
number. The default port is 8080.

Notes: 

➤ To integrate ALM with IIS or an Apache Web server, see the HP 
Software Self-solve knowledge article KM1383166: 
(http://h20230.www2.hp.com/selfsolve/document/KM1383166). (Requires 
HP Passport sign-in credentials)

➤ If an error message is displayed that the default port is unavailable, the 
port may be in use by another application running on the server 
machine. Either locate the application and stop it, or enter a different 
port number. To enter a different port number, you must first change 
the port number on the application server. For details, see "Changing 
the Application Server Port Number" on page 165. Then proceed with 
the configuration as normal. 

➤ You can update the heap memory value after you have installed ALM. 
For details, see Chapter 16, "Managing the ALM Application Server."

Click Next.

http://h20230.www2.hp.com/selfsolve/document/KM1383166
http://h20230.www2.hp.com/selfsolve/document/KM1383166
http://h20230.www2.hp.com/selfsolve/document/KM1383166
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 27 The HP ALM Service page opens.

Type the User Name, Password, and Domain to be used to run the 
application server as a service. This enables the service to access your local 
network.
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 28 The Mercury Tours page opens.

To help you get started with ALM, install the sample Web-based travel 
reservation application, Mercury Tours. This is a prerequisite for working 
with the HP Application Lifecycle Management Tutorial.

Note: It is recommended that you import the ALM Demo Project 
available with the ALM 11.50 installation DVD. Importing this project 
enables you to run all lessons in the HP Application Lifecycle Management 
Tutorial. In Site Administration, import the ALM_Demo.qcp file. For more 
information on importing projects, refer to the HP Application Lifecycle 
Management Administrator Guide.

Click Next. 
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 29 The Mail Server page opens.

To enable ALM to send emails to users in an ALM project, select a mail 
protocol. For SMTP Server, type the server name. 

If you selected Microsoft IIS SMTP Service, you must configure the 
Microsoft IIS SMTP service. For more information, see "Configuring the 
IIS Mail Service" on page 113.

Click Next.

 30 The Installation Summary page opens. To change any settings, click Back.

To accept the settings and start the configuration process, click Next.
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 31 The Finish page opens.

Click Finish.

If the installation process fails, check the installation logs for details. For 
more information see "Checking the Installation and Configuration Log 
Files" on page 186. 

If you selected to upgrade a copy of the existing Site Administration 
database schema, it is possible that an upgrade related issue caused the 
configuration to fail. Check the following files located in the 
<file repository path>/sa/Admin/maintenancedata/out directory for 
more information:

➤ upgrade.txt

➤ verifyreport.html

If it is clear from these files that the failure was due to changes made to 
the existing Site Administration database schema, you need to create an 
exceptions file that excludes these changes from the upgrade process. You  
then need to run the configuration wizard again. For more information, 
see "Changes to the Existing Schema and Upgrade Failure" on page 36.
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 32 If you are prompted to restart your computer, you can choose to restart 
your computer at a later time, but you must restart your computer before 
you use ALM. You must also restart your computer before you install any 
ALM related files, such as integration add-ins.

 33 If you are using an Oracle RAC database, verify that the 
ORACLE_RAC_SUPPORT site configuration parameter is set to "Y". For 
more information, refer to the HP Application Lifecycle Management 
Administrator Guide.

Notes:

➤ To work with ALM, you may need to disable conflicting applications 
that are running on the ALM machine. For a list of these applications, 
see HP Software Self-solve knowledge base article KM176429 
(http://h20230.www2.hp.com/selfsolve/document/KM176429). (Requires 
HP Passport sign-in credentials).

➤ The Configuration Wizard creates the qcConfigFile.properties file in 
the following directory: c:\ProgramData\HP\ALM\conf. The file 
should not be moved from this location.

➤ The Configuration Wizard creates the repid.txt file in the <ALM 
Repository path>\qc folder. The file should not be moved from this 
location.

 34 The installation of ALM is now complete. Proceed to Chapter 13, "Getting 
Started."

http://h20230.www2.hp.com/selfsolve/document/KM176429
http://h20230.www2.hp.com/selfsolve/document/KM176429
http://h20230.www2.hp.com/selfsolve/document/KM176429


Chapter 11 • Installing on Microsoft Windows Systems

112

Installing ALM in Silent Mode

You can install ALM using a silent installation. A silent installation runs the 
entire setup process in the background without requiring you to navigate 
through the setup screens and input your selections. Instead, all 
configuration parameters are assigned values that you define in a 
configuration file. To run silent installations for different configurations, 
you can create multiple configuration files.

When running an installation in silent mode, no messages are displayed. 
Instead, you can view installation information in the log file, including 
information on whether the installation was successful. The installation log 
file can be found under the %tmp% directory.

To run a silent installation:

 1 Uninstall any previous installations of Quality Center or ALM from the 
server machine.

 2 Create the qcConfigFile.properties file.

The qcConfigFile.properties file defines the configuration values that are 
used during the installation.

It is recommended that you use an existing qcConfigFile.properties file 
from a prior installation of ALM. 

If there is no existing file, you can create one manually. However, this can 
be a complicated process that is open to errors. We suggest that you create 
one by running a normal installation. During the installation process, the 
file is automatically created. The configuration values you define during 
the installation process are recorded in the file. Even if you subsequently 
uninstall ALM, you can keep and edit the file as needed for future 
installations.

The file is automatically saved in the following path:
c:\ProgramData\HP\ALM\conf 
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 3 From the command line, run the run_silent.bat file on the installation 
DVD. The file is located in the appropriate .zip folder for your operating 
system (32-bit or 64-bit).

In the command line, add the -c <configuration file full path> parameter 
to specify the path of the configuration file, for example,  
c:\Users\qcadmin\Desktop\qcConfigFile.properties.

Optionally, add the -i parameter to specify an alternative installation 
path.

Configuring the IIS Mail Service

If you selected Microsoft IIS SMTP Service in the Mail Server Properties 
dialog box, you must configure the Microsoft IIS SMTP service.

To configure the IIS mail service:

 1 Open the Internet Information Services (IIS) Manager window.

 2 In the Tree pane, right-click Default SMTP Virtual Server and select 
Properties. The Default SMTP Virtual Server Properties dialog box opens.

 3 In the Access tab, click the Connection button. The Connection dialog 
box opens. Select All except the list below and click OK.

 4 Click the Relay button. The Relay Restrictions dialog box opens. Select All 
except the list below and click OK.

 5 Click OK to close the Default SMTP Virtual Server Properties dialog box.
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12
Installing on Linux/Oracle Solaris Systems 

This chapter describes how to install HP Application Lifecycle Management 
(ALM) on a Linux or an Oracle Solaris operating system.

Note: For information on installing ALM on Windows systems, see 
"Installing on Microsoft Windows Systems" on page 89.

This chapter includes:

➤ About Installing ALM on page 115

➤ Installing ALM on page 116

➤ Installing ALM in Silent Mode on Linux/Solaris Systems on page 139

➤ Working in Console Mode on page 140

About Installing ALM

You can install ALM on a single node or as a cluster. When you install ALM 
on cluster nodes, all nodes must be identical. For example, all nodes must 
use the same operating system, ALM repository location, and Site 
Administration database. In addition, you must install the same version of 
ALM on all nodes.

If you are working in a clustered environment, you must mount the file 
system repository before you start the ALM installation process. The mount 
should not use any cache mechanisms. For details, contact your network 
administrator.
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Note: When you are installing ALM on a secondary node of a cluster you are 
not required to set up the database, because it was set up when you installed 
the primary node. Some of the dialog boxes described in this installation 
procedure are needed only for the primary node and are not displayed if you 
are installing a secondary node.

Installing ALM

This section describes how to install ALM 11.50.

Before installing ALM, consider the following:

➤ Verify that you meet the various installation prerequisites. For 
prerequisite information, see the relevant chapter in Part 3, "Pre-
Installation Prerequisites."

➤ If you worked with a previous version of ALM/Quality Center, you must 
upgrade your Site Administration database schema and projects. For more 
information, see Chapter 3, "Upgrade Overview."

➤ If you encounter problems during the ALM installation process, see 
Appendix A, "Troubleshooting the ALM Installation," for troubleshooting 
suggestions.

➤ By default, the installation and configuration processes run in console 
mode. Navigating from one wizard step to the next requires familiarity 
with the various console mode command types. For explanations of the 
various command types and the methods for entering configuration 
settings, see "Working in Console Mode" on page 140.

To install ALM:

 1 If you have been working with a previous version of Quality Center or 
ALM, back up your existing projects before installing the new version. For 
more information, refer to the HP Application Lifecycle Management 
Administrator Guide.
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 2 Log in to the ALM host machine with the appropriate permissions. For a 
list of required permissions, see "Required Permissions: Linux/Solaris" on 
page 60.

 3 If Quality Center or ALM is installed on the machine, uninstall it. For 
more information, see Chapter 18, "Uninstalling ALM."

 4 The installation process can be run in console mode only. After the 
installation is complete, the ALM Server Configuration wizard enables 
you to configure the installation. By default, the wizard runs in console 
mode. 

To run the wizard using a graphical user interface, make sure that the 
DISPLAY environment variable is configured accordingly on the ALM host 
machine and that the machine from which you are installing is running 
an X-server (for example, Exceed).

If the variable is already configured and you want to run the 
configuration wizard in console mode, make sure the variable is changed 
accordingly.

For help with the variable settings, contact your technical support team.

 5 Create an installation directory on the server, for example: 
/usr/Install/ALM.

 6 Insert the ALM 11.50 Software installation DVD into the DVD drive. 
Under the mount folder, navigate to the appropriate installation 
subfolder for your system. For example: 

➤ Linux: /mnt/dvd/ALM-Linux

➤ Solaris: /mnt/dvd/ALM-Solaris 

 7 Copy the entire contents of the subfolder to the installation directory you 
created on the server.

 8 Run the following chmod command to allow permissions for the 
installation files: chmod -R 777 <installation directory>.
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 9 From the installation directory on the server, navigate to, and run the 
installer.sh file.

Note: If anti-virus software is installed on the server machine, it checks 
every file as it is being copied. Therefore, deployment may take longer 
than expected.

 10 The HP Application Lifecycle Management Setup Wizard page opens, 
displaying the Welcome page. 

Select Next to continue.
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 11 The License Agreement page is displayed. 

Read the agreement. To accept the terms of the agreement, select Agree.

 12 The Select Installation Directory page is displayed, displaying the default 
location for the installation files. 

To keep the default path, select Next, or select Select a different directory 
to define another directory. 

Note: If you change the default, a soft link (symbolic link) with the 
default directory path is created which points to the directory you define.
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 13 The Confirmation page is displayed. 

If you do not wish to change any of the settings, select Install to proceed 
with the installation. Alternatively, select Back to change a previous 
setting, or Cancel to abort the installation.

If you select Install, ALM files are installed on the server machine.

 14 When the installation process completes, the Finish page is displayed. 

To complete the Setup Wizard, select Finish.
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 15 The HP ALM Server Configuration wizard starts, displaying the Welcome 
page. 

Select Next to proceed to the next page. 

Note: If you are performing a sudo installation, close the wizard and run 
the run_after_install.sh file as a non-root user. For more information on 
running a sudo installation, see the following HP Software Self-solve 
knowledge base article (Requires HP Passport sign-in credentials):   
http://support.openview.hp.com/selfsolve/document/KM916123

 16 If the wizard detects settings from a previous ALM installation, the 
Current Settings page is displayed. 

By default, current settings are used. The current settings appear as 
defaults in subsequent wizard screens. You can then make changes to any 
of the previous settings.

Choose to keep or clear the current settings, then proceed to the next 
page.

http://support.openview.hp.com/selfsolve/document/KM916123
http://support.openview.hp.com/selfsolve/document/KM916123
http://support.openview.hp.com/selfsolve/document/KM916123
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 17 The License Key page is displayed. 

 a Enter the ALM License file path.

If you have a License key file, enter the ALM License file path. If you 
do not have a key file, you can leave this field empty and proceed with 
an evaluation key.

 b Enter the Maintenance key. 

If you have a Maintenance key, enter it now. If you do not have a key 
file, you can leave this field empty and proceed. 

 c Use an evaluation key.

If you do not have a License key, you can use an evaluation key for a 
30-day trial version of ALM. A list of available ALM editions is 
displayed. 

From the editions list, choose the edition you want to use.
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 18 The Database Server page is displayed.

 a Select the database type.

For more information on database requirements, see Chapter 7, 
"Prerequisites: Oracle Database Servers" or Chapter 8, "Prerequisites: 
Microsoft SQL Database Servers".

 b Select a database connection method.

Select one of the following:

➤ Database Parameters. Enables you to enter database server 
information. 

➤ Connection String. Enables you to type a formulated database server 
connection string. If you select this option, proceed to step d on 
page 124.

Choose Connection String to use an Oracle RAC database, and enter 
a string, specifying the location of the tnsnames.ora file, and the 
TNS server that ALM should refer to. Use the following example:

For more information on prerequisites for Oracle RAC support, see 
"Oracle RAC Support" on page 70.

jdbc:mercury:oracle:TNSNamesFile=<tnsnames.ora location>;
TNSServerName=OrgRAC
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 c Enter Database Parameters:

If you select the Database Parameters connection method, enter the 
following information:

➤ DB host name. Type the database server name. 

➤ DB port number. Type the database server port number, or accept 
the default port number. To accept the default, enter 1, then press 
Enter.

➤ Oracle SID. Type the Oracle system identifier. This is an Oracle 
parameter that identifies the specific Oracle instance on the host 
machine on which the Oracle server is installed.

 d Enter Database Administrator Login information.

Specify the following:

➤ DB admin user name. The name of the user with the administrative 
permissions required to connect ALM to the database server. 

➤ DB admin password. The database administrator password.
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 19 The Site Administration Database Schema page opens. 

 a Select a Site Administration database schema option.

Select one of the following:

➤ Create a New Schema. Creates a new Site Administration database 
schema. This is the default option.

➤ Upgrade a copy of the existing schema. Creates a copy of the 
existing Site Administration database schema, and upgrades the 
copy. Choose this option to work in ALM 11.50 and previous 
versions of ALM/Quality Center simultaneously. For more 
information, see "Upgrading Existing Schema" on page 32.

If you select this option, you are prompted to add an exceptions file 
to the upgrade process. If you have defined an exceptions, enter the 
location of where it was saved prior to the installation process. For 
more information about exceptions files, see "Changes to the 
Existing Schema and Upgrade Failure" on page 36.
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➤ Connect to existing schema / second node. This option can be used 
in two scenarios:

If you are reinstalling ALM and would like to reconnect to the same 
Site Administration database schema.

If you have an existing node and you want to install ALM on 
another node to create a cluster. For more information on cluster 
configuration, see "Clustering Configuration: Linux/Solaris" on 
page 62.

Note: This option enables you to connect to an ALM 11.50 Site 
Administration database schema only. To connect to an earlier 
version of Site Administration, you must first upgrade the schema. 
For more information, see "Upgrading Existing Schema" on page 32.

 b Enter Oracle Tablespace information. 

If you are using an Oracle database, enter the following information. If 
you are using a Microsoft SQL database, proceed to step c on page 127:

Note: If you are installing ALM on a secondary node or if the Site 
Administration database already exists, the new Site Administration 
database schema is created in the same tablespace as the existing 
schema. Proceed to step 22.
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➤ Temporary Tablespace. The Temporary Tablespace is the location on 
the database where temporary tables are created in order to facilitate 
internal database functionality, such as large sorting tasks. It is 
recommended that you accept the default location. 

➤ Default Tablespace. The Default Tablespace is the location on the 
database where database objects will be created, unless specified 
otherwise. 

Select a location from the list.

 c Enter Site Administration database schema details. 
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Enter the following information:

➤ Schema name. Enter a name for the Site Administration database 
schema, or accept the default. 

If you selected Upgrade a copy of the existing schema, the New 
Schema name option appears. Type a name for the upgraded copy 
of the Site Administration database schema.

Note: When upgrading an existing Site Administration database 
schema to work in ALM 11.50, you must use the same name that 
you used before the upgrade.

➤ Schema password. Enter the following information, depending on 
your database type:

Oracle: A default password is created which you can accept or 
change. 

Microsoft SQL Server (SQL Auth.): ALM uses the td user to create the 
Site Administration database schema. For more details on the td 
user, see "User Permissions for Connecting ALM to a Microsoft SQL 
Server" on page 75.

Type a password for the td user that complies with your 
organization’s password policy, or keep the default tdtdtd password.
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 20 The Security page is displayed.

Passwords for accessing external systems (databases and LDAP) are stored 
by ALM after encryption. Enter a Confidential data passphrase that ALM 
uses to encrypt the information or choose to use the default value. If you 
use the default value however, the encrypted information is more 
vulnerable to unauthorized access.

Make a note of the passphrase for future support calls. You will also need 
the passphrase if you choose to redeploy ALM and choose to upgrade a 
copy of the existing Site Administration Database Schema.

Confidential Data Passphrase Considerations

➤ When upgrading from an ALM 11.00 version of the Site 
Administration database schema, you must enter the same passphrase 
as was used for the previous installation. If you do not know the 
passphrase, there is a workaround to recover it. However, you will have 
to abort the configuration process and then begin again once the 
workaround is complete. For details, see "Recovering a Lost 
Confidential Data Passphrase" on page 35.

➤ If you are planning to migrate Performance Center and/or Lab 
Management enabled projects onto the server on which you are 
performing the installation, you must use the same Confidential Data 
Passphrase that was defined on the server on which the projects were 
created.
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➤ If you are installing ALM on a cluster, you must use the same 
passphrase for all nodes.

➤ After completing the server configuration wizard, you cannot change 
the confidential data encryption passphrase.

➤ The passphrase is case-sensitive. Check that there are no empty spaces 
before or after the passphrase.

 21 Enter a Communication Security Passphrase:

Communication between ALM and other HP BTO applications is enabled 
after authentication by a Single Sign-On (SSO) token. Enter a 
Communication security passphrase that ALM uses to encrypt the SSO 
token.

Notes:

➤ The communication security passphrase is stored as the value of the 
COMMUNICATION_SECURITY_PASSPHRASE site configuration parameter. 
For more information, refer to the HP Application Lifecycle Management 
Administrator Guide.

➤ Performance Center: You must use the same communication security 
passphrase for the Performance Center server configuration.



Chapter 12 • Installing on Linux/Oracle Solaris Systems

131

 22 The Site Administrator User page is displayed.

You use the site administrator name and password that you define here to 
log in to Site Administration for the first time. After installation, you can 
change the site administrator or add other site administrators. Type a site 
administrator User name (maximum length 60 characters) and Password, 
and retype the password to confirm.

If you are upgrading a copy of the existing Site Administration database 
schema, by default the same user and credentials are applied to the 
upgraded Site Administration database schema. The Create additional 
Site Administrator user option is displayed, enabling you ignore this 
default and create an additional user.

Notes:

➤ The user name cannot include the following characters: \ / : * ? " < > |

➤ It is important that you remember the site administrator user name 
and password as otherwise you cannot log in to Site Administration.
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 23 The File Repository Path page is displayed.

Accept the default path or enter a new path. If you choose to ignore the 
default, make sure to enter a unique case-sensitive path.

Notes:

➤ Make sure you select a path where you have full read and write 
permissions.

➤ To work with cluster nodes, make sure that all nodes have access to the 
file repository path and that the path is UNC. All nodes in the cluster 
must have the same repository path.

Using the BASE_REPOSITORY_PATH site configuration parameter, you 
can create a location for a repository path where new projects will be 
located. Performing this action, results in the creation of two repository 
paths - the previous path containing older projects, and a second path 
containing projects created subsequently. For details, refer to the 
HP Application Lifecycle Management Administrator Guide.
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 24 The Application Server page opens. 

 a Enter Deployment Path information.

Enter a Deployment path, where you specify the location in which you 
want to deploy ALM application files. It is recommended that you keep 
the default. 

 b Enter Web server information. 

Change or keep the default HTTP port number. The default port is 
8080.
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Notes: 

➤ To integrate ALM with IIS or an Apache Web server, see the HP 
Software Self-solve knowledge article KM1383166: 
(http://h20230.www2.hp.com/selfsolve/document/KM1383166). (Requires 
HP Passport sign-in credentials)

➤ If an error message is displayed that the default port is unavailable, it 
may be the port is in use by another application running on the server 
machine. Either locate the application and stop it, or enter a different 
port number. To enter a different port number, you must first change 
the port number on the application server. For details, see "Changing 
the Application Server Port Number" on page 165. Then proceed with 
the configuration as normal. 

➤ You can update the heap memory value after you have installed ALM. 
For details, see Chapter 16, "Managing the ALM Application Server."

http://h20230.www2.hp.com/selfsolve/
document/KM1383166
http://h20230.www2.hp.com/selfsolve/
document/KM1383166
http://h20230.www2.hp.com/selfsolve/
document/KM1383166
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 25 The Mercury Tours page is displayed. 

To help you get started with ALM, install the sample Web-based travel 
reservation application, Mercury Tours. This is a prerequisite for working 
with the HP Application Lifecycle Management Tutorial.

Note: It is recommended that you import the ALM Demo Project 
available with the ALM 11.50 installation DVD. Importing this project 
enables you to run all lessons in the HP Application Lifecycle Management 
Tutorial. In Site Administration, import the ALM_Demo.qcp file. For more 
information on importing projects, refer to the HP Application Lifecycle 
Management Administrator Guide.
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 26 The Mail Server page is displayed. 

To enable ALM to send emails to users in an ALM project, choose SMTP 
Server. Then when prompted, enter the server name.

 27 The Installation Summary page is displayed. To change any settings, select 
Back.

To accept the settings and start the configuration process, select Next.

 28 The Finish page is displayed. 

Enter 1, then press Enter to start ALM.

If the installation process fails, check the installation logs for details. For 
more information see "Checking the Installation and Configuration Log 
Files" on page 186. 



Chapter 12 • Installing on Linux/Oracle Solaris Systems

137

If you selected to upgrade a copy of the existing Site Administration 
database schema, it is possible that an upgrade related issue caused the 
configuration to fail. Check the following files located in the <file 
repository path>/sa/Admin/maintenancedata/out directory for more 
information:

➤ upgrade.txt

➤ verifyreport.html

If it is clear from these files that the failure was due to changes made to 
the existing Site Administration database schema, you will need to create 
an exceptions file that excludes these changes from the upgrade process. 
You will then need to run the configuration wizard again. For more 
information, see "Changes to the Existing Schema and Upgrade Failure" 
on page 36.

 29 If you are prompted to restart your computer you can choose to restart 
your computer at a later time but you must restart your computer before 
you use ALM. You must also restart your computer before you install any 
ALM related files, such as integration add-ins.

 30 If you are using an Oracle RAC database, verify that the 
ORACLE_RAC_SUPPORT site configuration parameter is set to "Y". For 
more information, refer to the HP Application Lifecycle Management 
Administrator Guide.
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Notes:

➤ To work with ALM, you may need to disable conflicting applications 
that are running on the ALM machine. For a list of these applications, 
see HP Software Self-solve knowledge base article KM176429 
(http://h20230.www2.hp.com/selfsolve/document/KM176429). (Requires 
HP Passport sign-in credentials)

➤ The Configuration Wizard creates the qcConfigFile.properties file in 
the following directory: /var/opt/HP/ALM/conf. The file should not be 
moved from this location.

➤ The Configuration Wizard creates the repid.txt file in the <ALM 
Repository path>\qc folder. The file should not be moved from this 
location.

 31 The installation of ALM is now complete. Proceed to Chapter 13, "Getting 
Started."

http://h20230.www2.hp.com/selfsolve/
document/KM176429
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Installing ALM in Silent Mode on Linux/Solaris Systems

You can install ALM using a silent installation. A silent installation runs the 
entire setup process in the background without requiring you to navigate 
through the setup screens and input your selections. Instead, all 
configuration parameters are assigned values that you define beforehand in 
a configuration file. To run silent installations for different configurations, 
you can create multiple configuration files.

Note: When running an installation in silent mode, no messages are 
displayed. Instead, you can view installation information in the log file, 
including information on whether the installation was successful. The 
installation log file can be found under the home directory (~) of the user 
installing ALM.

To run a silent installation:

 1 Uninstall any previous installations of Quality Center or ALM from the 
server machine.

 2 Create the qcConfigFile.properties file.

The qcConfigFile.properties file defines the configuration values that are 
used during the installation.

It is recommended that you use an existing qcConfigFile.properties file 
from a prior installation of ALM. 

If there is no existing file, you can create one manually. However, this can 
be a complicated process that is open to errors. We suggest that you create 
one by running a normal installation. During the installation process, the 
file is automatically created. The configuration values you define during 
the installation process are recorded in the file. Even if you subsequently 
uninstall ALM, you can keep and edit the file as needed for future 
installations.

The file is automatically saved in the following path:
/var/opt/HP/ALM/conf 
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 3 Create an installation directory on the server, for example: 
/usr/Install/ALM

 4 Insert the ALM 11.50 Software installation DVD into the DVD drive and 
under the mount folder, navigate to the appropriate installation subfolder 
for your system. For example: 

➤ Linux: /mnt/dvd/ALM-Linux

➤ Solaris: /mnt/dvd/ALM-Solaris 

 5 Copy the entire contents of the subfolder to the installation directory you 
created on the server.

 6 Run the following chmod command to allow permissions for the 
installation files: chmod -R 777 <installation directory>

 7 From the installation directory on the server, navigate to, and run the  
silent.sh file.

In the command line, add the -c <configuration file full path> parameter 
to specify the path of the configuration file.

Working in Console Mode

By default, the ALM Server Configuration Wizard runs in console mode. 
Navigating from one wizard step to the next requires familiarity with the 
various console mode command types. This section explains the various 
command types and the methods for entering configuration settings.

List Options
Some wizard screens present a set of options in the form of a list, where you 
can select only one option. For example:
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To make your selection, type the numeric value of the option you wish to 
select, then press Enter. 

The page appears again, this time with the checkmark placed by the option 
you selected. In this example, if you enter 2, then press Enter, the following 
appears: 

To confirm your selection, type 0 then press Enter.

For information about how to move to the next step, see "Moving to the 
Next Step" on page 142.

Text Options
Some wizard screens require you to enter text. For example:

If the wizard detects a pre-existing value for the required field, or if there is a 
default value, that value appears in brackets. For example:

To ignore the existing value:

Type a new value then press Enter. The new value overrides the existing 
value.

For information about how to move to the next step, see "Moving to the 
Next Step" below.
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To keep the current value, or leave the field empty:

Press Enter. The following option appears:

To proceed to the next step with the existing value, type 1 then press Enter. 

To proceed to the next step and leave the field empty, type 2 then press 
Enter. 

For information about how to move to the next step, see "Moving to the 
Next Step" below.

Moving to the Next Step
After entering information, either from a list or by entering text, you are 
prompted with the following options to proceed: 

Type a number and press Enter.

➤ Next. ALM validates the settings you have entered. If the validation is 
successful, the next step is displayed. If the validation fails, an error 
message is displayed.

➤ Previous. Displays the beginning of the previous configuration step. 
Values that you have already entered for the previous step appear as 
existing values.

➤ Cancel. Cancels the configuration.

➤ Redisplay. Displays the beginning of the current configuration step. 
Values that you have already entered for the step appear as existing 
values.
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13
Getting Started

This chapter introduces HP Application Lifecycle Management (ALM) 
options and resources. It also explains how to start Application Lifecycle 
Management.

This chapter includes:

➤ Browsing the ALM Program Folder on page 145

➤ Starting and Stopping ALM Services on page 146

➤ Starting Application Lifecycle Management on a Client on page 147

➤ Registering ALM on a Workstation on page 151

Browsing the ALM Program Folder

In Windows, after the ALM setup process is complete, the following items 
are added to your ALM program folder (Start > Programs > HP ALM Server):

Option (A-Z) Description

ALM Server Opens ALM. For more information, refer to the 
HP Application Lifecycle Management User Guide.

Mercury Tours Opens a sample flight reservation Web application. 
This Web application is used as a basis for the 
HP Application Lifecycle Management Tutorial. For more 
information, refer to the HP Application Lifecycle 
Management Tutorial.

Note: This application is only available if you selected 
it during the ALM installation.
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Starting and Stopping ALM Services

This section describes how to start or stop ALM services.

To start or stop ALM services from Windows: 

In the system tray, right-click the ALM icon and choose Start Application 
Lifecycle Management or Stop Application Lifecycle Management.

Online Documentation Opens the Documentation Library, providing access to 
ALM guides and references that are available online, in 
PDF format, or both.

Readme Opens the HP Application Lifecycle Management Readme, 
which provides the latest news and information about 
ALM.

Server Configuration 
Wizard

Runs the HP ALM Server Configuration Wizard, 
enabling you to reconfigure ALM.

Caution: Use this option only if you have not yet 
started working in ALM.

Server Deployment 
Wizard

Redeploys ALM. Run after making changes to the Site 
Administration repository or application folders. For 
more information, see Chapter 17, "Customizing 
System Files."

Site Administration Opens the Site Administration application. For more 
information, refer to the HP Application Lifecycle 
Management Administrator Guide.

Option (A-Z) Description



Chapter 13 • Getting Started

147

Starting Application Lifecycle Management on a Client

You launch HP Application Lifecycle Management (ALM) on your 
workstation from your Web browser.

You can work with multiple versions of ALM side-by-side on a workstation. 
This includes multiple ALM 11.00/11.50 clients connecting to different ALM 
servers, and a single Quality Center 10.00 or 9.2 client.

To enable you to log in to Application Lifecycle Management, you must first 
create a project in Site Administration. For more information, refer to the 
HP Application Lifecycle Management Administrator Guide.

Notes:

➤ To enable ALM to work with HP testing tools as well as third-party and 
custom tools, you must run the HP ALM Client Registration add-in, 
which registers ALM components on the client machine. For more 
information, see "Registering ALM on a Workstation" on page 151.

➤ If your users connect to ALM over a virtual environment, such as Citrix 
or VMware, you can deploy ALM components on a shared location that 
all users can access. To enable a shared deployment, run the Shared 
Deployment for Virtual Environments add-in from the HP Application 
Lifecycle Management Add-ins page. For more information, see 
Chapter 15, "Installing HP ALM Add-ins."
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To start Application Lifecycle Management:

 1 Open your Web browser and type your ALM URL
http://<ALM server name>[<:port number>]/qcbin.

The Application Lifecycle Management Options window opens.

The Application Lifecycle Management Options window contains the 
following links:

Option Description

Application Lifecycle 
Management

Opens the ALM application. For more information, 
refer to the HP Application Lifecycle Management User 
Guide.

Site Administration Opens the Site Administration application. For more 
information, refer to the HP Application Lifecycle 
Management Administrator Guide.

Add-ins Page Opens the HP Application Lifecycle Management 
Add-ins page. For more information, see "Installing 
HP ALM Add-ins" on page 159.

Readme Opens the ALM Readme, which provides the latest 
news and information about ALM.
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 2 Click the Application Lifecycle Management link. Each time ALM is run, 
it carries out a version check. If it detects a newer version, it downloads 
the necessary files to your machine.

Follow the on-screen instructions.

Notes:

➤ Windows 7/2008/2008R2: If you do not have administrator privileges 
on your machine and a Security Warning displays, click Don’t Install. 
You will be redirected to the Install screen.

➤ If you run ALM over a virtual environment such as Citrix, only the 
system administrator can install a new version.

➤ If files are downloaded but the Login window does not display, you 
must install a Microsoft Hotfix on your machine. For more 
information, see the HP Software Self-solve knowledge base article: 
http://h20230.www2.hp.com/selfsolve/document/KM905289. 
(Requires HP Passport sign-in credentials)

http://support.openview.hp.com/selfsolve/document/KM905289
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After the ALM version has been checked and files have been updated as 
necessary, the Application Lifecycle Management Login window opens.

 3 In the Login Name box, type your user name.

 4 In the Password box, type the password. If you cannot remember your 
password, click the Forgot Password link. For more information, refer to 
the HP Application Lifecycle Management User Guide.

 5 Select the Automatically log in to my last domain and project on this 
machine check box if you want ALM to automatically log in to the last 
project in which you were working.

 6 Click Authenticate. ALM verifies your user name and password and 
determines which domains and projects you can access. If you specified 
automatic login, ALM opens.

If authentication fails, check that your user name and password are 
correct and try again.
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 7 In the Domain list, select a domain. By default, the last domain in which 
you were working is selected.

 8 In the Project list, select a project. By default, the last project in which 
you were working is selected.

 9 Click Login. ALM opens and displays the module in which you last 
worked during your previous session.

Registering ALM on a Workstation

To enable you to work with other HP testing tools as well as third-party and 
custom tools, ALM must be registered on the client machine.

Note: If you are running previous versions of ALM/Quality Center on your 
machine, before registering ALM 11.50, make sure that all instances of 
ALM/Quality Center and any integration tools are closed.

For a list of the tools that require registering ALM on a machine, see "Tools 
that Require Registering ALM Client Components" on page 153.

To register ALM on a workstation:

 1 Log on to the machine as a local user or a domain user with administrator 
privileges. Ensure that you have the registry and file system permissions 
listed below.

Windows 7/2008/2008R2: Open the Web browser as an administrator 
(right-click the Internet Explorer icon and select Run as Administrator).

 2 Run HP ALM Client Registration from the HP Application Lifecycle 
Management Add-ins page. For more information, see Chapter 15, 
"Installing HP ALM Add-ins."

 3 Close and reopen the Web browser.
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Permissions Required to Register ALM on a Workstation
You must have full read and write permissions on the following registry 
keys:

➤ HKEY_CLASSES_ROOT

➤ HKEY_CURRENT_USER\Software

➤ HKEY_LOCAL_MACHINE\SOFTWARE

You must have the following file system permissions:

➤ Full read and write permissions on the HP\ALM-Client deployment folder. 
This is located at:

➤ Windows 7/2008/2008R2: %ALLUSERSPROFILE%

➤ Windows XP: %ALLUSERSPROFILE%\Application Data

➤ Full read and write permissions to the Temp (%TEMP% or %TMP%) 
directory. The installer program writes installation and log files to this 
directory. This is generally located at:

➤ Windows XP: 
C:\Documents and Settings\<username>\Local Settings\Temp

➤ Windows 7: C:\Users\<username>\AppData\Local\Temp
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Tools that Require Registering ALM Client Components
The following tools require that ALM client components be registered on 
the client machine.

HP ALM Add-ins ➤ QuickTest Professional Add-in

Note: Requires that Data Execution Prevention (DEP) 
be disabled in Windows 7.

➤ Microsoft Word Add-in

➤ Microsoft Excel Add-in

➤ HP Screen Recorder Add-in

➤ Service Test Add-in

➤ HP ALM Synchronizer

➤ Defects and Requirements Exchange with HP Service 
Manager and HP ALM

HP ALM Extensions ➤ HP Business Process Testing Enterprise Extension

Note: Required only if working with QTP/STM agents 
remotely.

Other QuickTest Professional tests

Notes:

➤ Required to run tests, and to submit defects from the 
Run Results Viewer.

➤ Requires that Data Execution Prevention (DEP) be 
disabled in Windows 7.
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14
Integrating the ALM Application 
Server with Apache

To use HP Application Lifecycle Management (ALM) with an Apache Web 
server, you need to configure the Apache Web server to redirect requests to 
the ALM Application Server. You configure the Apache Web server to work 
in proxy HTTP mode.

Note: It is recommended that you use Apache HTTP Server version 2.2 or 
below.

To configure Apache to work in proxy http mode:

 1 Make sure the Apache Web server is stopped.

 2 Navigate to the <Apache Home directory>\conf directory.

 3 Open the httpd.conf file.

 4 Uncomment or add the following load module commands: 

Note: Make sure that both modules exist in your Apache installation.

LoadModule proxy_module modules/mod_proxy.so
LoadModule proxy_http_module modules/mod_proxy_http.so
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 5 Add the following section to the file:

Note: If you are connecting to ALM on a remote machine, replace 
localhost with the IP address or name of the server on which ALM is 
installed. 

# Turn off support for true Proxy behavior as we are acting as 
# a transparent proxy 
ProxyRequests Off 

# Turn off VIA header as we know where the requests are proxied 
ProxyVia Off 

# Turn on Host header preservation so that the servlet container 
# can write links with the correct host and rewriting can be avoided. 
ProxyPreserveHost On 

# Set the permissions for the proxy 
<Proxy *> 
   AddDefaultCharset off 
   Order deny,allow 
   Allow from all 
</Proxy>

# Turn on Proxy status reporting at /status 
# This should be better protected than: Allow from all 
ProxyStatus On 
<Location /status> 
   SetHandler server-status 
   Order Deny, Allow 
   Allow from all 
</Location>
 
# Configuring mod_proxy_http 
# To connect to servlet container with HTTP protocol, the ProxyPass directive can be 
# used to send requests received on a particular URL to a Jetty instance. 

ProxyPass /qcbin http://localhost:8080/qcbin 
ProxyPass /mtours http://localhost:8080/mtours 
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 6 Save the changes to the file.

 7 Restart the Apache Web server.

You can now connect to your ALM site using the following URL: 
http://<ALM server name>[<:apache port number>]/qcbin.
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15
Installing HP ALM Add-ins

HP Application Lifecycle Management (ALM) offers integration and 
synchronization solutions with HP and third-party tools. To integrate ALM 
with other tools, you may need to install appropriate add-ins from the 
HP Application Lifecycle Management Add-ins page.

Note: If you are integrating ALM with another tool, you can verify that you 
are using a supported version of the tool. On the Add-ins page, click the 
More HP Application Lifecycle Management Add-ins link, and choose the 
appropriate integrations matrix.
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To install an ALM add-in:

 1 Click Add-ins Page in the Application Lifecycle Management Options 
window when logging into ALM, or choose Help > Add-ins Page in the 
ALM main window. The HP Application Lifecycle Management Add-ins 
page opens.  

The following ALM add-ins are available:

➤ HP ALM Connectivity. Enables you to integrate ALM with other tools.

➤ HP ALM System Test Remote Agent. Enables you to run a system test 
on a machine. You can run a system test to retrieve a machine’s system 
information, view a captured desktop image of a test run on a 
machine, or restart a machine.

➤ HP Sprinter. Provides advanced functionality and a variety of tools to 
assist in the manual testing process.

➤ HP ALM Client Registration. Registers ALM components on the client 
machine, enabling you to work with HP testing tools as well as third-
party and custom tools.

➤ Shared Deployment for Virtual Environments. Deploys ALM 
components on a shared location that can be accessed by all users. 
This is useful if users connect to ALM over a virtual environment, such 
as Citrix or VMware.



Chapter 15 • Installing HP ALM Add-ins

161

➤ More HP ALM Add-ins. Enables you to install additional add-ins. The 
add-ins include integration and synchronization solutions with HP 
and third-party tools.

 2 Click an add-in link. A page with additional information about the add-in 
opens. If you click the More HP ALM Add-ins link, the More HP ALM 
Add-ins page opens, enabling you to select additional add-ins.

 3 Click the add-in guide link (where applicable) for instructions on using 
the add-in.

 4 Click the Download Add-in link to download and install the add-in. 
Follow the instructions on your screen.
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16
Managing the ALM Application Server

From ALM 11.50 and above, application server functionality is included 
with core ALM capability as opposed to the use of an integrated third-party 
application server, as was the case in previous versions of ALM. The internal 
application server is referred to as the ALM Application Server. 

This chapter contains information relating to managing the ALM 
Application Server, as well as information regarding general Java 
management tools.

This chapter includes: 

➤ Changing the Heap Memory Size on page 164

➤ Changing the Application Server Port Number on page 165

➤ Configuring Secure Access on Windows Systems on page 166

➤ Configuring Secure Access on Linux/Solaris Systems on page 169

➤ Application Server Management Tools on page 172
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Changing the Heap Memory Size

After you install ALM, you may need to change the heap memory values. 
For example, you may want to increase the heap size if there is an increase 
in the number of active projects in ALM, or an increase in the number of 
concurrent user sessions.

Note: 

➤ The maximum heap value cannot exceed your maximum memory 
(RAM) size.

➤ On a machine running on a 32-bit operating system, the heap memory 
size should not exceed 1024MB.

To change the heap memory size:

 1 Verify that all users have logged out of ALM projects and stop the ALM 
Service as follows:

➤ Windows. In the system tray, right click the ALM icon and choose Stop 
Application Lifecycle Management.

➤ Linux/Solaris. Navigate to the /var/opt/HP/ALM/wrapper directory, 
and run the following command: HPALM stop.

 2 In the ALM deployment path, open the wrapper.conf file.

 3 Change the wrapper.java.maxmemory value as necessary.

 4 Restart the ALM Service as follows:

➤ Windows. In the system tray, right click the ALM icon and choose 
Start Application Lifecycle Management.

➤ Linux/Solaris. Navigate to the /var/opt/HP/ALM/wrapper directory, 
and run the following command: HPALM start.
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Changing the Application Server Port Number

After you install ALM, you may need to change the application server port 
number.

It is possible that the default application server port may be in use by 
another application that is running on the same machine. In this case, you 
can either locate the application that is using the port and stop it, or you 
can change the application server port on the machine.

To change the application server port number:

 1 Verify that all users have logged out of ALM projects and stop the ALM 
Service as follows:

➤ Windows. In the system tray, right click the ALM icon and choose Stop 
Application Lifecycle Management.

➤ Linux/Solaris. Navigate to the /var/opt/HP/ALM/wrapper directory, 
and run the following command: HPALM stop.

 2 Navigate to the <ALM deployment path>/HP/ALM/server/conf/jetty.xml 
file.

 3 Change the jetty.port value.

 4 Restart the ALM Service as follows:

➤ Windows. In the system tray, right click the ALM icon and choose 
Start Application Lifecycle Management.

➤ Linux/Solaris. Navigate to the /var/opt/HP/ALM/wrapper directory, 
and run the following command: HPALM start.
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Configuring Secure Access on Windows Systems

The following procedure describes how to configure a Secure Socket Layer 
(SSL) connection when ALM is installed on a Windows system.

To configure SSL:

 1 Verify that all users have logged out of ALM projects and stop the ALM 
Service as follows: In the system tray, right click the ALM icon and choose 
Stop Application Lifecycle Management. 

 2 Navigate to the <ALM deployment path>\server\conf\ directory and 
make a backup of the jetty.xml file.

Caution: Make sure that you back up the jetty.xml file located in this 
directory.

 3 Open the jetty.xml file and add the following section under the Configure 
element:

 4 Replace the C:\CAs\server.keystore path with the location of your 
keystore file.

 5 If you want to change the port number, replace 8443 with the new port 
number.

<Call name="addConnector">
  <Arg>
    <New class="org.eclipse.jetty.server.ssl.SslSocketConnector">
      <Set name="host"><Property name="jetty.host" /></Set>
      <Set name="Port">8443</Set>
      <Set name="maxIdleTime">30000</Set>
      <Set name="keystore">C:\CAs\server.keystore</Set>
      <Set name="password">changeit</Set>
      <Set name="keyPassword">changeit</Set>
      <Set name="truststore">C:\CAs\server.keystore</Set>
      <Set name="trustPassword">changeit</Set>
    </New>
  </Arg>
</Call>
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 6 If you have changed the default keystore password, replace changeit with 
the new password.

 7 (Optional) To encrypt the password, perform the following steps:

 a Open Command Prompt and run the following command:

For example, if you run the following command: 

 The output will appear as follows:

 b Replace the plain text password in the jetty.xml file with the output 
above, including the OBF and MD5 prefix.

<JAVA_HOME>\java \ -cp "<DEPLOYMENT_HOME>\server\lib\*" 
org.eclipse.jetty.http.security.Password <password>

java -cp "C:\ProgramData\HP\ALM\server\lib*" 
org.eclipse.jetty.http.security.Password changeit

changeit
OBF:1vn21ugu1saj1v9i1v941sar1ugw1vo0
MD5:b91cd1a54781790beaa2baf741fa6789
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 8 (Optional) To disable non-HTTP access to the ALM Application Server, in 
the jetty.xml file, locate the following section and comment it out by 
placing <!-- at the beginning of the section, and --> at the end.

Note: It is possible that this section in your jetty.xml file is slightly 
different.

 9 Save the jetty.xml file. 

 10 Restart the ALM Service as follows: In the system tray, right click the ALM 
icon and choose Start Application Lifecycle Management. 

 11 Connect to ALM using port 8443, or the number of the new port if you 
changed it in step 5 on page 166. 

<!--
<Call name="addConnector">
  <Arg>
    <New class="org.eclipse.jetty.server.nio.SelectChannelConnector">
      <Set name="host"><Property name="jetty.host" /></Set>
      <Set name="port"><Property name="jetty.port" default="8080"/></Set>
      <Set name="maxIdleTime">300000</Set>
      <Set name="Acceptors">2</Set>
      <Set name="statsOn">false</Set>
      <Set name="confidentialPort">8443</Set>
      <Set name="lowResourcesConnections">20000</Set>
      <Set name="lowResourcesMaxIdleTime">5000</Set>
    </New>
  </Arg>
</Call>
-->
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Configuring Secure Access on Linux/Solaris Systems

The following procedure describes how to configure a Secure Socket Layer 
(SSL) connection when ALM is installed on a Linux/Solaris system.

To configure SSL:

 1 Verify that all users have logged out of ALM projects, and stop the ALM 
Service. To stop the service, navigate to the /var/opt/HP/ALM/wrapper 
directory, and run the following command: HPALM stop.

 2 Navigate to the /var/opt/HP/ALM/server/conf/ directory and make a 
backup of the jetty.xml file.

Caution: Make sure that you back up the jetty.xml file located in this 
directory.

 3 Open the jetty.xml file and add the following section under the Configure 
element:

 4 Replace the /home/admin/downloads path with the location of your 
keystore file.

 5 If you want to change the port number, replace 8443 with the new port 
number.

<Call name="addConnector">
  <Arg>
    <New>
      <Set name="host"><Property name="jetty.host" /></Set>
      <Set name="Port">8443</Set>
      <Set name="maxIdleTime">30000</Set>
      <Set name="keystore">/home/admin/Downloads/server.keystore</Set>
      <Set name="password">changeit</Set>
      <Set name="keyPassword">changeit</Set>
      <Set name="truststore">/home/admin/Downloads/server.keystore</Set>
      <Set name="trustPassword">changeit</Set>
    </New>
  </Arg>
</Call>
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 6 If you have changed the default keystore password, replace changeit with 
the new password.

 7 (Optional) To encrypt the password, perform the following steps:

 a Open Command Prompt and run the following command:

For example, if you run the following command: 

 The output appears as follows:

 b Replace the plain text password in the jetty.xml file with the output 
above, including the OBF and MD5 prefix.

./java -cp ".:/var/opt/HP/ALM/server/lib/*:/var/opt/HP/ALM/server/lib/ext/" 
org.eclipse.jetty.http.security.Password <password> 

./java -cp ".:/var/opt/HP/ALM/server/lib/*:/var/opt/HP/ALM/server/lib/ext/" 
org.eclipse.jetty.http.security.Password changeit

changeit
OBF:1vn21ugu1saj1v9i1v941sar1ugw1vo0
MD5:b91cd1a54781790beaa2baf741fa6789
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 8 (Optional) To disable non-HTTP access to the ALM Application Server, in 
the jetty.xml file, locate the following section and comment it out by 
placing <!-- at the beginning of the section, and --> at the end.

Note: It is possible that this section in your jetty.xml file is slightly 
different.

 9 Save the jetty.xml file. 

 10 Restart the ALM Service by navigating to the /var/opt/HP/ALM/wrapper 
directory running the following command: HPALM start. 

 11 Connect to ALM using port 8443, or the number of the new port if you 
changed it in step 5 on page 169. 

<!--
<Call name="addConnector">
  <Arg>
    <New class="org.eclipse.jetty.server.nio.SelectChannelConnector">
      <Set name="host"><Property name="jetty.host" /></Set>
      <Set name="port"><Property name="jetty.port" default="8080"/></Set>
      <Set name="maxIdleTime">300000</Set>
      <Set name="Acceptors">2</Set>
      <Set name="statsOn">false</Set>
      <Set name="confidentialPort">8443</Set>
      <Set name="lowResourcesConnections">20000</Set>
      <Set name="lowResourcesMaxIdleTime">5000</Set>
    </New>
  </Arg>
</Call>
-->



Chapter 16 • Managing the ALM Application Server

172

Application Server Management Tools

Since the ALM Application Server is a Java-based, we recommend the 
following Java tools to enable you to effectively manage ALM:

jconsole:

http://java.sun.com/developer/technicalArticles/J2SE/jconsole.html

jstack:

http://download.oracle.com/javase/1.5.0/docs/tooldocs/share/jstack.html

jmap:

http://download.oracle.com/javase/1.5.0/docs/tooldocs/share/jmap.html

jvisualvm:

http://download.oracle.com/javase/6/docs/technotes/tools/share/jvisualvm.html

Notes:

➤ Jvisualvm is an all-in-one tool that was added in Java 1.6. However the 
other tools may still be useful as there may be implications regarding 
memory and CPU usage with jvisualvm as it is a heavier tool.

➤ To troubleshoot issues relating to the management tools, see "Monitoring 
ALM Server Fails" on page 189.

http://java.sun.com/developer/technicalArticles/J2SE/jconsole.html
http://download.oracle.com/javase/1.5.0/docs/tooldocs/share/jstack.html
http://download.oracle.com/javase/1.5.0/docs/tooldocs/share/jmap.html
http://download.oracle.com/javase/6/docs/technotes/tools/share/jvisualvm.html
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17
Customizing System Files

You can customize various aspects of HP Application Lifecycle Management 
(ALM), by creating or configuring system files.

This chapter includes: 

➤ Customizing Site Administration on page 173

➤ Customizing Menus on page 175

➤ Understanding the ALM System Tray Icon on page 178

Customizing Site Administration

Customization of the Site Administration repository and the qcbin 
application must be performed in the ALM deployment directory. For 
example, if you edit .xsl mail stylesheets, or create custom test types. After 
customizing any of the files in the deployment directory, you must redeploy 
ALM.

Caution: You must not modify, add, or delete files in the ALM installation 
directory.

This section includes:

➤ Customizing the Site Administration Repository

➤ Customizing the qcbin Application
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Customizing the Site Administration Repository
Perform the following procedure to customize the Site Administration 
repository. 

 1 On the machine on which ALM is installed, open a file browser, and 
navigate to <ALM installation path>\data\sa.

 2 Open another file browser, and navigate to 
<ALM repository path>\customerData.

 3 In the installation directory, navigate to the file that you want to 
customize.

 4 In the repository directory, under customerData, create the same folder 
structure that contains the file in the installation directory.

 5 Copy the file from the installation directory and paste the file in the 
appropriate folder in the repository directory.

 6 Edit the file in the repository directory.

 7 Run the Server Deployment Wizard:

On Windows systems: Choose one of the following:

➤ Start > HP ALM Server > Server Deployment Wizard

➤ <installation path>\bin\run_server_deploy_tool.bat

On Linux/Solaris systems: 
<installation path>/bin/run_server_deploy_tool.sh

Customizing the qcbin Application
Perform the following procedure to customize the qcbin application.

To customize the qcbin application:

 1 On the machine on which ALM is installed, open a file browser, and 
navigate to <ALM installation path>\application\20qcbin.war.

 2 Open another file browser, and navigate to 
<ALM deployment path>\application\20qcbin.war.

 3 In the installation directory, navigate to the file that you want to 
customize.
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 4 In the deployment directory, under 20qcbin.war create the same folder 
structure that contains the file in the installation directory.

 5 Copy the file from the installation directory and paste the file in the 
appropriate folder in the deployment directory.

 6 Edit the file in the deployment directory.

 7 Run the Server Deployment Wizard:

On Windows systems: Choose one of the following:

➤ Start > HP ALM Server > Server Deployment Wizard

➤ <installation path>\bin\run_server_deploy_tool.bat

On Linux/Solaris systems: 
<installation path>/bin/run_server_deploy_tool.sh

 8 Repeat the procedure on each cluster node.

Customizing Menus

You can customize the Application Lifecycle Management Tools and Help 
menus by modifying the ALM-Client.exe.config file on the machine on 
which ALM is installed.

To customize ALM:

 1 On the machine on which ALM is installed, extract the ALM-
Client.exe.config file from Client.cab. This file is located in: 
<ALM deployment path>\deployment\20qcbin.war\Install

 2 Open the ALM-Client.exe.config file (this is in .xml format).
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 3 You can change or delete the Document Generator item in the Tools 
menu. This is defined in the Tools section of the file. In the same section 
you can also add new items to the Tools menu.

The following is the syntax of an entry in the Tools line:

 4 To change, delete, or rearrange the list of items in the Help menu, change 
the default names, IDs, and URLs listed in the OnlineHelpItem line. The 
following is the syntax of an entry in the OnlineHelpItem line:

To create a separator line between two items in the Help menu, use the 
following syntax:

Note: The first two menu items in the Help menu, Help on this page and 
Documentation Library, and the last Help menu item, 
About HP Application Lifecycle Management Software, cannot be moved 
or changed. They do not have corresponding entries in the 
QualityCenter.exe.config file. The above step only affects the menu items 
between them.

<TDFrame
      Tools="<Tool_Name>,{<Tool_ID>}"
      Workflow="{<Workflow_ID>}"
      Parameters="<parameters>"
 />

<OnlineHelpItem 
ID="<Help_ID>" 
Name="<Help_Name>" 
Url="<Help_URL>" 

<OnlineHelpItem 
ID="<Help_ID>" 
Name="<Help_Name>" 
Url="<Help_URL>" 
IsFirstInGroup="true" />



Chapter 17 • Customizing System Files

177

 5 Unzip the Client.cab file to a temporary folder named Client which must 
be under the temp folder. For example, C:\temp\Client.

 6 Replace the ALM-Client.exe.config file with the modified file.

 7 Store the temporary folder on a logical drive, for example X, by running 
the following command:

For example, subst X: C:\temp

 8 Create a new Client.cab file with the command:

Note: To use this command you must first download cabsdk.exe (the 
Cabinet Software Development Kit) from the Microsoft Download Center.

 9 Add a class 3 digital signature to the new Client.cab file.

Note: The digital signature must be a signature of a trusted provider.

 10 Under <ALM deployment path>\application\20qcbin.war, create a new 
Installation folder, if it does not already exist.

 11 Save the new cab file under the Installation folder.

 12 Run the Server Deployment Wizard:

On Windows systems: Choose one of the following:

➤ Start > HP ALM Server > Server Deployment Wizard

➤ <installation path>\bin\run_server_deploy_tool.bat

subst [X]: <temp folder>

cabarc -r -p -P Client\ -s 6144 N <temp folder>\Client.cab X:\Client\*.*
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On Linux/Solaris systems: 
<installation path>/bin/run_server_deploy_tool.sh

 13 Repeat the procedure on each cluster node.

Understanding the ALM System Tray Icon

The ALM system tray icon indicates the current status of ALM. It also 
indicates the current action that ALM is performing.

You can customize the behavior of the icon by modifying the 
trayConfigFile.properties file.

To customize the system tray icon:

 1 Navigate to the following directory: 
C:\ProgramData\HP\ALM\server\conf

 2 Open the trayConfigFile.properties file.

 3 Change the following properties as necessary:

➤ pollingintervalMillis. Defines, in milliseconds, how often the ALM 
system tray icon checks the status (started or stopped) of ALM. The 
default value is 5,000.

➤ logDebugMode. Defines whether debugging information is included 
in the system tray log. The default value is false.

➤ timeoutintervalMillis. Defines, in milliseconds, the maximum amount 
of time ALM takes to change the status of ALM when you right-click 
the icon and choose Start/Stop ALM Server. If ALM is not able to 
perform the action in the allotted time the status changes to Error. The 
default value is 180,000.
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18
Uninstalling ALM

You can uninstall HP Application Lifecycle Management (ALM) from the 
server machine. When uninstalling ALM, projects are not deleted. You can 
also uninstall ALM client components from a workstation that has been 
used to access Application Lifecycle Management.

This chapter includes:

➤ Uninstalling ALM from Windows systems on page 179

➤ Uninstalling ALM from Linux/Solaris Systems on page 180

➤ Uninstalling ALM Client Components from a Workstation on page 180

Uninstalling ALM from Windows systems

This section describes how to uninstall ALM from your Windows server 
machine. 

 1 Choose Start > Control Panel.

 2 Depending on your operating system:

➤ 2008: In Home view, under Programs, click Uninstall a program. In 
Classic view, double-click Programs and Features.

➤ 2008 R2: In Category view, under Programs, click Uninstall a program. 
In Large/Small icons view, click Programs and Features. 

 3 In the programs list, right-click HP Application Lifecycle Management 
and select Uninstall.

 4 Follow the instructions on your screen.
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 5 (Optional) To remove all traces of ALM from the machine, delete all 
remaining files in the installation directory as well as the deployment 
path. Also delete the \HP\ALM folders in the c:\ProgramData directory 
and their files.

Uninstalling ALM from Linux/Solaris Systems

This section describes how to uninstall ALM from your Linux/Solaris server 
machine.

Note: You must log in as the same user that installed ALM.

To uninstall ALM from Linux/Solaris systems:

 1 Navigate to the /var/opt/HP/iHP/HP_ALM_Server/<version number> 
directory.

 2 Run the install.sh file.

 3 (Optional) To remove all traces of ALM from the machine, delete all 
remaining files in the installation directory as well as the deployment 
path. Also delete the /HP/ALM folders in the /var/opt directory and their 
files.

Uninstalling ALM Client Components from a Workstation

When you run ALM on your client computer, client components are 
downloaded to your workstation. You can use the client uninstall utility to 
remove all ALM client components, including files and registry keys. To 
download the utility, see the HP Software Self-solve knowledge base article 
KM176290 (http://h20230.www2.hp.com/selfsolve/document/KM176290). 
(Requires HP Passport sign-in credentials)

If the workstation is used to access ALM after the uninstall utility has been 
run, all necessary components are downloaded again from the ALM server.

http://h20230.www2.hp.com/selfsolve/
document/KM176290
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A
Troubleshooting the ALM Installation

This chapter contains troubleshooting suggestions for issues relating to the 
HP Application Lifecycle Management (ALM) installation.

This chapter includes:

➤ Disabling Validation Checks for the Configuration Wizard on page 183

➤ Checking the Installation and Configuration Log Files on page 186

➤ ALM Installation Already Exists on page 187

➤ Database Validator Fails on page 188

➤ Monitoring ALM Server Fails on page 189

Disabling Validation Checks for the Configuration Wizard

The ALM Server Configuration Wizard automatically performs validation 
checks to verify that particular system configurations requirements are met. 
If the ALM configuration does not complete due to a failed validation, you 
can disable selected validation checks and rerun the ALM Server 
Configuration Wizard.

Caution: You should disable validation checks only if you are sure that the 
validation result is wrong.
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Notes:

➤ To resolve failures that occur during the ALM Server Installation Wizard, 
see "Checking the Installation and Configuration Log Files" on page 186, 
or "ALM Installation Already Exists" on page 187.

➤ For troubleshooting tips on database validations, see "Database Validator 
Fails" on page 188.

To disable configuration validators and rerun the ALM Server Configuration 
Wizard:

 1 In the ALM installation directory, locate the run_after_finish.bat file 
(Windows) or the run_after_install.sh (Linux/Solaris) file. The purpose of 
these files is to start the ALM Server Configuration Wizard.

 2 In the installation directory, create a copy of the file. Make sure to save 
the copy using a different name, for example: 
run_after_finish_skip_validation.bat

 3 Edit the new file by adding skip validation flags as required. The file itself 
contains instructions how to add the flags.

 4 Save and then execute the new file.

Configuration Validators

Validator Checks To disable

Operating 
system and 
license

Checks that the operating system 
is supported.

-wOsValidator

Existing 
installation

Checks if an older version of ALM 
or Quality Center is installed. For 
troubleshooting tips, see "ALM 
Installation Already Exists" on 
page 187.

-wPreviousInstallationValidator

License file Checks license file key. -wLicenseTypeValidator
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Security 
passphrases

Checks encryption passphrases. -wEncryptionStepValidator

Mail server Checks that the mail server name 
is valid.

-wMailServerValidator

Database 
connectivity

Checks database connectivity. -wDbSettingsStepValidator

Database 
settings

Checks Site Administration 
database settings.

-wSaSchemaValidator

Site 
administrator

Checks site administrator user 
settings.

-wSiteAdminUserValidator

Repository 
folder

Checks that the repository folder 
is accessible, and has sufficient 
space.

-wRepositoryValidator

Validator Checks To disable
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Checking the Installation and Configuration Log Files

If you encounter problems installing ALM, check for errors in the following 
log files:

Linux/Solaris File Delivery Logs

Windows File Delivery Logs

Application Logs

Log Path

Native package 
installation log

/var/log/<date>_HP_ALM_Server_install_log.txt

Installation sequencer 
wizard log

/var/log/<date>_HP_ALM_Server_11.50.000_iHP_log

Prerequisites log /var/log/<date>_HP_ALM_Server_11.50.000_
prerequisites_iHP_log.txt

Log Path

Custom actions logs %temp%\ihp_custom_batches.log

%temp%\iHP.Runtime.CustomActions.HP_Application_
Lifecycle_Management_Server.log

Log Path

Configuration logs Windows: C:\Users\All Users\HP\ALM\log

Linux/Solaris: \var\opt\HP\ALM\log

Site Administration 
database schema 
creation logs

<ALM deployment folder>\log\sa
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ALM Installation Already Exists

If during installation, an error message displays, indicating that an ALM 
installation already exists, verify that ALM is not installed and that there are 
no traces of an old installation.

To verify that ALM is not installed:

 1 From the Start menu, choose Control Panel > Add/Remove Programs.

 2 In the program list, check for HP Quality Center or HP Application 
Lifecycle Management Platform.

 3 If either appears in the program list, click Remove and follow the 
instructions on your screen.

 4 After you uninstall ALM Server, check that the 
<ALM Server home>\application directory was deleted. If it was not 
deleted, delete the directory before you re-install ALM Server.

To remove traces of an old ALM Server installation:

 1 Navigate to the system root (%systemroot%) directory (on Linux/Solaris 
systems, go to the /home directory).

 2 Back up the vpd.properties file.

 3 Open the vpd.properties file for editing and delete any lines that mention 
ALM Server.
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Database Validator Fails

During ALM Server configuration, if the database validator fails perform the 
following checks:

➤ Check that the input parameters are correct.

➤ Check that the Site Administration database schema name was provided.

➤ If upgrading a Microsoft SQL Server Site Administration database schema, 
check whether the same authentication type was used as the one used in 
the previous installation.

To check whether the parameters are correct:

 1 Read the error message that displays during installation and try to 
understand and resolve the problem from the root cause.

 2 For further clarifications, check with your database administrator.

 3 If no error was found and you are sure that the parameters are correct, 
disable the DB parameters validator as described in "Disabling Validation 
Checks for the Configuration Wizard" on page 183.

To check that the Site Administration database schema name was provided:

 1 Open a database query tool.

 2 Make sure the PROJECTS table exists in the schema. This table exists in 
the schema only and not in the project schema.

To check the SQL authentication type of a previous installation (when 
upgrading an SQL Server site schema):

 1 Navigate to C:\Program Files\HP\ALM Server on Windows, and /opt/
HP/HP_ALM_Server on Linux/Solaris and open the application folder.

 2 Extract the contents of qcbin.war into a temp file, and open the 
siteadmin.xml file in a text editor.

 3 Search for the “native” property. If its value is set to “Y”, Windows 
authentication was used. Make sure that the new installation uses the 
same authentication type (Microsoft SQL Server authentication or 
Windows authentication) as the previous installation.
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Monitoring ALM Server Fails

Problem: When running one of the Java-based tools to monitor ALM you 
receive the following message: 

Not enough storage is available to process this command.

Reason: This problem is caused because the JVM running ALM Server is 
running with a service account.

Solution: Choose one of the following, depending on which tool you are 
running:

➤ jmap and jstack. See the suggestion in the following link:

http://stackoverflow.com/questions/906620/
jstack-and-not-enough-storage-is-available-to-process-this-command

You will be required to download the pstools tool from the following 
address: 

http://technet.microsoft.com/en-us/sysinternals/bb897553

➤ jconsole and jvisualvm. Download the following tool from the following 
address:

http://www.iopus.com/guides/srvany.htm

Also refer to the following Microsoft article: http://support.microsoft.com/
kb/137890
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